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Chapter 1 
Installation 

FeatureCAM Product Line 
 FeatureCAM products include:   

• FeatureMILL2.5D – 2.5D design and toolpath generation for 2 and 3-axis mills. 

• FeatureMILL3D – 3D surface modeling and 3-axis toolpath generation 

• Solid Modeling – Solid modeling and tools for creating molds from solid models.   

• FeatureRECOGNITION – 3D surface and solid import and the recognition of 2.5D features 
from solid models.  Accelerates making 2.5D and turned parts from solid models.   

• FeatureTURN – 2-axis design and toolpath generation for 2-axis lathes.   

• FeatureTURN/MILL – Supports lathes with C and Y-axis milling capabilities.   

• FeatureWIRE – 2 and 4axis wire EDM toolpath creation.   

• 5-axis Positioning – Manufacture 2.5D features from 5-axis orientations.   

• Tombstone – Multiple part manufacturing for horizontal or vertical milling machines with 
indexers.    

• Machine Simulation – Modeling and simulation of a CNC machine. 

• Multi-turret Turning- Use of multiple turrets for production turning. 

• Network – Flexible product licensing allows sharing FeatureCAM licenses across a network.   

• Native Import Modules – Import Catia, Unigraphics, Pro/E and STEP files.   
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Installing the Dongle 
A dongle is supplied with FeatureCAM for copy protection. The dongle is a physical device that 
attaches to your computer's parallel printer port or a USB port.  FeatureCAM checks to see if a dongle 
is present before it generates NC code for your parts or before saving a file.   The dongle must remain 
connected for the entire time you are running FeatureCAM.   

 

 

 

 

 

  USB Dongle    Parallel Dongle 

If you downloaded a copy of FeatureCAM over the Internet, or your product box is marked as 
Evaluation Copy, you do not have a dongle. You can draw and simulate designs, but you can’t 
generate NC code, save, or export any files.  

If the side of your product box says Upgrade then you purchased an upgrade version of FeatureCAM 
and you must use the dongle you received with your earlier FeatureCAM purchase.  

If you have a dongle, install it on your computer by inserting it in the parallel printer port (or USB port 
if using a USB dongle) and screwing in the thumbscrews. The dongle is programmed for an initial 
period (see Registration below). If you have licensed FeatureCAM, then you are given a code to 
provide unlimited use when you register your copy.  

You may have multiple devices attached to your parallel port. Many computers have a printer attached 
to that port. If you have any devices attached to the port, you will need to chain the devices in sequence 
and the FeatureCAM dongle should be the first in the stack.  Note that you may not connect multiple 
FeatureCAM dongles to a single parallel port.   

The dongle is a pass through device. You can attach your dongle to the computer and the other devices 
can hook up to the dongle. You may have to experiment with the order of devices a bit to find which 
sequence works best with your devices. Printers should probably be at the end of the device chain. In 
general, try to put the FeatureCAM dongle in as the first or second device in the sequence.  
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Installation Procedures 
Use the following information to help you install the program and dongle (software key). 

For information on installation issues not covered here, refer to the README.WRI and 
RELNOTES.WRI files on the FeatureCAM Installation CD. These files are also copied to the hard 
disk in the EZFM directory in a successful installation. 

If you’re upgrading an older copy, you can safely overwrite old versions of FeatureCAM. When you 
are prompted for the installation directory, simply use the same directory you did last time. Your part 
files and customizations are preserved and can be used with this version of FeatureCAM. 

If you wish to continue to run your older copy of FeatureCAM, then install the new version in a 
different directory.  Be aware that your old version may not be able to read files from your new 
version, but the new version will always be backwards compatible with older versions of files.   

The following instructions are written for a CD ROM that is drive D. Substitute the actual drive letter 
where appropriate. 

1. Attach the dongle, if you have one, to your printer port. 

2. Put the CD in drive D. 

3. If installing from CD, the installation screen should automatically be displayed.  

4. If installing from disks or if the installation screen does not automatically come up, choose Run 
from the Start menu. Type d:\setup if installing from CD.  

5. Follow the instructions on the installation screens.  

Entering Temporary/Evaluation Codes  
If you purchased an upgrade to an existing copy of FeatureCAM, your package will contain temporary 
codes for activating your dongle until you get a chance to register.  You must enter these codes to run 
your new version.   If you purchased a new package with a new dongle inside, you do not have to 
complete these steps.   

Run FeatureCAM. 

If the New Part Document Wizard comes up, click Cancel.   

If you have any windows open in FeatureCAM, close them.   

Select Evaluation Options from the File menu. 

Click Next. 

Click I have an evaluation code and click Next.   
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Enter your evaluation code in the space provided and click Finish.   

Hints on Entering FeatureCAM Registration Codes 
1. Evaluation codes are a collection of the digits 0-9 and the letters A-F.   

2. There are no letter Os in the codes, only the number zero. 

3. The case of the letters does not matter.  Spaces are also ignored.   

 

Registration 
You must register your new copy of FeatureCAM even if it is an upgrade to an older version. If you’re 
not sure whether you purchased an upgrade or not, look at the side of your FeatureCAM box. If 
Upgrade is checked, you purchased an upgrade to your existing copy of FeatureCAM.  

1. If FeatureCAM is not already running, run FeatureCAM from the Start menu.  

2. If you purchased a new copy of FeatureCAM, the Registration dialog box is displayed.   

3. If you are updating an existing copy, close all the windows in FeatureCAM (without closing the 
application itself) and select Evaluation Options from the File menu. 

4. If you did not purchase an upgrade, you will see Must register in the Status column of the 
components you purchased. Your dongle will initially work for a limited amount of time.  You 
must register them to remove this limitation.  

5. If you did purchase an upgrade, the products that you licensed in previous versions will have Yes 
in the evaluating column.  Those components that are already enabled for the version you are 
installing will have a status of Fully enabled. These products will not need to be registered again. 

6. Click Next. 

Filling Out Registration Forms 
Please fill out the registration form included in the FeatureCAM box and follow the instructions on it. 
If you do not have a copy of the form please contact our corporate office at the toll-free number 1-888-
393-6455 ext 10, 1-801-575-6021 ext 10 (outside of the United States) or email a request to 
admin@featurecam.com. 
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After Receiving Your Code 
1. Run FeatureCAM. 

2. Click Next in the Registration dialog box.  

3. Click I have registered and have a code. 

4. Select the product(s) that you received codes for. Click Next.  

5. Enter code(s).  

6. Click OK.  

7. You will see the message Thank you for registering FeatureCAM.  

Your product is now registered and fully enabled.  

FeatureCAM Maintenance Releases 
If you have purchased and registered a version of a FeatureCAM product, you are allowed to install 
maintenance releases free of charge. A maintenance release is any product version with the same first 
number as the product you are licensed to run. For example Version 13.0.1.36 the first number is 13. 

To check to see if a new version of your FeatureCAM product is available: 

1. Make sure you are connected to the Internet and select Check for new version from the Help 
menu.   

2. If a more current version is available you are offered the option of updating your version of the 
FeatureCAM.    

The first time you run your maintenance release the Registration dialog box may be displayed.  If this 
happens: 

1. Click Next. 

2. Click Finish. 
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Evaluating Products You Have Not Yet Purchased 
Once you are running FeatureCAM, you can evaluate other FeatureCAM products.  

1. Run FeatureCAM. 

2. If the New Part Document Wizard comes up, click Cancel.   

3. Select Evaluation Options from the File menu. 

4. Check the Evaluate checkboxes for the product components you want to evaluate. 

5. Click OK. 

FeatureCAM is now running in evaluation mode. You cannot save parts or post, but you can create 
part models and generate toolpaths.   You can tell FeatureCAM is in evaluation mode by the word, 
(evaluation), in the title bar.   

 

 

The next time you run FeatureCAM, the Registration dialog box is displayed. To run the program 
normally: 

 

1. Run FeatureCAM and click Next. 

2. Select Run the program and click Finish. 

3. If the New Part Document Wizard comes up, click Cancel. 

4. Select Evaluation Options from the File menu. 

5. Uncheck all the Evaluate checkboxes. 

6. Click OK. 
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Internet WEB Site 
The Internet WEB site http://www.featurecam.com contains useful information for FeatureCAM 
users including: 

1. New product announcements. 

2. A comprehensive database of technical tips.   

3. Maintenance releases. 

4. Evaluation copies of new software. 

5. Local dealer information. 

6. Tradeshows where FeatureCAM is being exhibited. 

There is no charge for accessing this WEB site, so feel free to access the latest information on 
FeatureCAM. 

FeatureCAM Network Licensing 
If you want to have the option of running your licensed FeatureCAM products on more than one 
computer, you may be interested in the FeatureCAM Network Licensing option. If you have licensed 
this option, see the READMEN.htm file located in the D:\netlic directory of the CDROM. 

FeatureCAM 2007 – What’s New 
If you are an existing FeatureCAM user and wish to find out about new functionality and other 
changes to FeatureCAM, see the What’s New section of the FeatureCAM help file. 
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Chapter 2 
Steps for Creating a Part 

The process for creating parts is laid out sequentially in the Steps toolbox.   By using each step, you are 
guided through the process of creating part programs with FeatureCAM.   

Step 1 - Stock.   The Stock Wizard steps you through entering the shape 
and dimensions of the stock, the stock material, part program zero and the 
coordinate system for modeling.   

Step 2 – Geometry.  Points, arcs, lines and other shapes are used to 
describe the overall shape of parts.  Many different geometry tools are 
available.  Geometry can also be imported from CAD systems.   

Step 3 – Curves.   Shapes that involve more than a single line or arc are 
described as curves.    For FeatureMILL3D customers there are also  
Surfaces and Solids step for creating 3D surface and solid models.   

Step 4 – Features.   Features are common shop terms like pocket, or 
thread.  They are created from curves and dimensions.  These objects 
describe your part in 3D and are used to generate toolpaths.   

Step 5 – Toolpaths.  Toolpaths are generated from collections of features.  
You can simulate them in FeatureCAM using toolpath centerlines, 2D 
shaded or 3D solid shaded simulations.   

Step 6 – NC Code.  Machine-specific G-codes are generated from the 
toolpaths.  Translators are provided for many different NC controls and include 
a program for creating new translators.   

Customize Manufacturing. FeatureCAM automates the entire part 
programming process, you can customize all of the system settings 
including feed/speed tables, tooling databases or feature settings.   



Steps for Creating a Part 

 10 

Startup:  New Part Dialog Box 
When you start FeatureCAM, the New Part Dialog Box is the first thing you see.  In this dialog box 
you can choose to open a new part file, or continue working on an existing file.  

 Step1:  Stock 
The stock is the initial material from which you will cut your part.  It can be rectangular, circular, a 
more general extruded shape, or a solid model.  The stock shape is used for 3D toolpath simulations 
and to control the extent of milling features like bosses.  FeatureCAM has embedded feed/speed tables 
for many different stock materials, so that feeds and speeds can be automatically calculated based on 
the stock material.   The Stock Wizard provides step-by-step instructions for specifying or modifying 
the general stock shape, specific stock dimensions, fixture IDs, part program zero, and the origin of 
your modeling coordinate system.  To navigate through the wizard, enter the desired information on 
each page and click the Next button to move to the next page.   

After completing this step, if you want to create holes, rectangular pockets, slots, circular pockets or 
thread mill features, you can skip to step 4.   

 Step 2:  Geometry 
Every part begins with an initial design. You may already have a part drawing, a part sketch or you 
may want to use FeatureCAM to draw your part design from scratch. The geometry step presents you 
with methods of creating points, lines, arcs and circles.   You can also clip geometry.  If you would like 
to create multiple objects, check the Create more than one option at the bottom of the dialog box 
before selecting the type of object you want to create.   

After selecting the type of object you want to create, you are provided instructions in the yellow 
Assistance bar at the bottom of the screen.  Type any numeric arguments that are required.  Use the 
TAB key to move to the next field.  For point coordinates you can type the individual X, Y and Z 
coordinates or use the mouse to graphically locate them in the Graphics window.  As you move the 
mouse around the Graphics window, you’ll notice that the cursor will snap to discrete locations like 
circle centers or line endpoints.  This location can be controlled by the Snapping dialog, which is 
discussed in Chapter 3.   

 Step 3:  Curves 
This step groups arcs and lines into curves by automatically tracing smooth paths.  If you want to make 
a feature from more than a single line, arc or circle, you must connect the geometry into a curve.   
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 Closed Boundary 

This option creates closed curves (curves that form a loop ) by clicking on one piece of geometry.  An 
attempt is made to create a closed loop by following smooth paths.  If this method does not result in 
the correct pieces, click the Clear pieces button at the bottom of the screen and select the Curves step 
again and use the Open boundary command.   

 Open Boundary 
This command creates curves by manually clicking on segments of the curves.  To create an open 
curve (curves that do not form a loop), click on the beginning of the curve and then click on the end.  If 
the resulting curve is not correct, click on a number of intermediate positions to guide the process of 
creating curves.  Closed curves can also be created with this technique by clicking back to the initial 
piece of geometry.   

 Step 4: Features 
Toolpaths are generated from features.  For example, if you want a hole in your part, choose the Hole 
feature. If your part has a pocket, choose the Pocket feature.  The Feature wizard walks you through 
the process of creating features.  One category of features is those that can be created solely from 
dimensions.  These features include holes, rectangular-shaped pockets, threads and round pockets 
(called Step Bores). 

Other features require curves to describe their shape.  They are listed under the From Curve category. 
These features include pockets, bosses, grooves, chamfers, rounds, sides and faces.    
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If you want to create a pattern of features, click the Make a pattern from this feature checkbox.  Click 
Next to step through the wizard.   

This wizard steps you through: 

• Selecting the feature type 

• Optionally entering pattern dimensions 

• Positioning the feature 

• Specifying the manufacturing strategy 

• Reviewing the automatically selected tools 

• Reviewing the automatically calculated 
feeds and speeds 

• Overriding the tooling and feed/speed 
values 

• Changing manufacturing attributes 

To modify a feature either double-click on a feature or select the feature and click the Properties 
button to open the Properties dialog box for a feature.  This dialog box presents all the screens of the 
New Feature Wizard in a single dialog box.  The individual screens are separated into different tabs of 
the dialog box. 

 Step 5:  Toolpaths 
This step displays the Simulation toolbar.   This toolbar has two sections, simulation types and 
simulation controls.  Select the mode of simulation you would like to run from among the simulation 
types.     

Speed Control Simulation Type Simulation ControlsEject Button 

Center 
Line 2D 3D Stop Play 

Single 
Step 

Next 
Flyout

.

Rapid 
Cut Clear 

Region 
of 

Interest 

Tool 
Load 

Fast 
Forward  
to End 

Machine 
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• Centerline simulation displays lines that represent the center of the tool.   

• 2D shows a color simulation from the top view.  Each operation is displayed in a different color.   

• 3D shows a 3-dimensional solid shaded simulation.   

• Rapid cut displays the final result without animating the tool.  (FeatureMILL3D only)   

• Machine simulation displays the entire machine. (Machine Simulation only) 

Once you select a simulation type, use the simulation controls to control the simulation.  Click the Play 
button to run the simulation.  (After pressing the play button, this button turns into the Pause button.  
Click this button again to pause the simulation.)  The Single Step button will display one toolpath 
move.  The Fast Forward to End button, displays all the toolpaths for the part without animating the 
results.  You can then view the toolpaths for each individual operation by clicking the Clear button and 
then clicking on an operation in the Operation List window.   

The Play to Next Operation button will display one complete operation such as a spot drill or a pocket 
roughing operation.  This button is actually a fly-out menu.  By clicking on the triangle to the right of 
the button the following additional options are revealed:   

• The Next Rapid button will simulate up to the next rapid 
move.   

• The Next Tool Change button will simulate up to the next 
tool change.  

• Play to Next Zlevel will display the next Z level of a Z 
level rough or finish operation.   

Use the Erase button to erase the centerline toolpaths on the screen. The Region of Interest is used to 
limit the portion of the part that is simulated for 3D or Rapid Cut simulations.  The Show tool load 
button indicates whether to display a graph of the tool load when the next 3D Simulation is performed.   
The Eject button removes the toolbar and the simulation from the screen.  The speed control slider 
controls how fast simulations run.  Move the slider to the right to speed up, or to the left to slow down.   

Center line simulation 2D simulation 3D simulation Machine simulation 
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If you see something in the simulation you want to change, you can override any of the tool choices, 
operation order, or the feeds and speeds if you wish.  Continue to simulate and fine-tune the part until 
you have the settings exactly right. 

 Step 6:  NC Code 
You generate NC code in FeatureCAM using this step.  

 Optimize Feedrates 
Use this option to even out the load on the tool by adjusting the feedrate of each NC block.   

 Display 

This option displays the code in the Manufacturing Results window.  You can also display the tooling 
lists and operations sheets by clicking the tabs located at the bottom of the Manufacturing Results 
window.   

 Save 
The NC code is saved to disk using this command.  You also have the option of saving additional 
documentation like tool lists, operations lists and part databases.   

 Remap Tooling 

This option allows you to change the locations of the selected tools in the tool changer.   
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 Customize Manufacturing 
This step allows you to customize the tooling databases, feed/speed 
databases, and the default system parameters.  These options allow 
you to fine tune FeatureCAM to your preferences.   

 

 

 Manufacturing Preferences 
Manufacturing preferences, or attributes, control the way a feature is manufactured.  FeatureCAM has 
two different types of attributes, default and feature.  Default attributes set the default settings for new 
features and are accessed by choosing the Customize Mfg. step and then selecting the Establish my  
manufacturing preferences option.  Indicate your preference for settings including climb milling, step 
over values, canned cycles or ramping and these settings will be used for all parts that you create.   

Feature attributes apply to specific features and override the default settings.  For example you may set 
a default setting for climb milling, but override it for bi-directional roughing for a particular feature.   

To set feature attributes, pick the feature graphically and click the Properties  button located at 
the bottom of the screen. 
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   Tooling  
FeatureCAM supports all the tool types in your shop including drills, taps, reamers, end mills, boring 
bars, and face mills. Each tool type is described by a series of dimensions.  

Tools are grouped into Tool Cribs. FeatureCAM provides a comprehensive tooling database and 
creates a basic tool crib for Inch, or Millimeter tools, or both. FeatureCAM selects tools from the 
active tool crib to manufacture the part. You can pick the tool crib you want to use for each part or 
machine. You can also create custom tool cribs with the Tool Manager to reflect the tools owned by 
your shop or to exactly represent the tools preloaded in your tool changer.   

 Material Database 
FeatureCAM comes standard with an integrated materials database.  Feeds and speeds are stored in 
tables for each material.  Each table contains the settings for different cutting operations.   These tables 
can be customized to change the values or you can add tables for new materials.   

 Configure Post Processor  
This option is available for customizing post processor settings or selecting a new post processor.   
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Optional Steps 

Surfaces 
This step is available in FeatureMILL3D.  This step launches the 3D surface wizard which steps you 
though creating surfaces from curves, primitive surfaces, surfaces from one surface, and surfaces from 
multiple surfaces.   

 Solids 
This step is available in the Solid Modeling option.  The Solids step initiates the Solids wizard which 
helps you create solids using numerous techniques.   

 AFR 
This step is available in the FeatureRECOGNITION option.  AFR stands for automatic feature 
recognition.  This step automatically recognizes features from solid models.   

On-line Help 
FeatureCAM has an extensive on-line help system included with the program. All documentation other 
than the Getting Started with FeatureCAM guide is on-line. This documentation includes product 
introductions and reference manuals for all FeatureCAM products.  
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Select FeatureCAM Help from the Help menu to display on-line help.  

Three different tabs are available. 

• Contents tab provides an outline view of the help system. Double click on a book or a page to 
open it. From a page, click Help Topics to return to the outline view.  

• Index tab allows you to access the help file using index topics. Type the topic name in the top box 
and click the Display button.  

• Search tab provides search capabilities for all pages of the help file. Type the word you would 
like to find in the top box and then pick a topic in the bottom box. Click Display to view the page.  

Help is a point and click interface to on-line information screens that are linked together. A link is any 
green underlined text or any portion of a diagram that turns the cursor into the pointer cursor. Click on 
a link to reveal a new screen.  

Reference Section 
The Reference section of the on-line help contains in-depth technical descriptions of FeatureCAM 
product features. It is organized in books that address major product topics. For example, the Drawing 
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book contains all the drawing tools contained in FeatureCAM; the Making features book contains a 
description of features broken down by individual products.  

What’s New Section 
This section keeps you up to date on the latest additions to FeatureCAM.   

Context Sensitive Help 
While using FeatureCAM you can access the documentation for the current topic by either: 

• Pressing F1 for help on your current activity.  

• Clicking Help in the dialog boxes.  

• Using the tool bar button, , for context sensitive help. Click this button and then click on a 
menu item, button or dialog box to receive more information.  

Written Documentation 
 

Formatted versions of manuals can be accessed from the Help menu and viewed using Adobe Acrobat.  
These versions of the documentation are convenient for searching or printing for viewing off-line.   
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Chapter 3 
Interface Tour 

FeatureCAM Interface Components 

The initial screen provides you with a clean interface for learning FeatureCAM. You can turn on the 
display of additional toolbars in the View menu under Toolbars. You can also control how much space 
the Graphics window uses compared to the Manufacturing results window by moving the Sliders from 
side to side. 

 
 

Standard 
Toolbar 

Menu Bar

Graphics Window 

Part View 
Toolbox 

Assistance Bar 

Status Bar

Geometry Dialog 
Bar 

Tabs

Manufacturing 
Results Window 

Sliders

Simulation ToolbarSimulation Toolbar

Steps Toolbox 
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Standard Toolbar 
A getting started guide can’t describe every button available in the new interface. But every button on 
a tool bar includes a tool tip. To view the tip, hold the cursor over the button until the tool tip appears. 
Tool tip describes the function the button activates. Besides the tool tip, the Assistance bar prompts 
you for the next step in the process. It senses your context and helps you design geometry and features. 
Refer to the Help system for detailed information. 

 

 

 

 

 

 

File functions are controlled in the first group of three buttons, such as creating a new file, opening an 
existing file, or saving the current file. 

View allows you to interactively change the view of the part. Select any of the options from the 
viewing fly-out. Your cursor shows the same icon as the viewing mode you selected. Viewing is 
performed interactively in FeatureCAM with the mouse. Rotation, panning and translation are 
possible.   Interactive viewing is disabled while simulating toolpaths or in select or edit modes. See the 
Fly-out Toolbars section below.      

Principal Views changes the view of a part to one of seven standard views. See the Fly-out Toolbars 
section below.  

Shaded allows you to work in shaded mode for solid modeling.   

Undo reverses the effect of the previous command.  FeatureCAM remembers a long list of the 
commands that are performed, so you can select Undo multiple times to undo multiple commands.   

Delete erases the object that is selected on the screen.  The object is removed from the system.   

Select puts you in Select mode. You can tell you are in select mode because the mouse appears as a 
standard arrow pointer in the part window. In select mode, you can click objects to select them.  

Transform moves or copies the selected entity according to settings you make in the dialog box. 

Context sensitive help accesses on-line help. Click the button, then select the button, field, dialog box 
or menu item you have questions about. 

Options provides access to all the options settings in FeatureCAM. 

Help brings up on-line help.   

Select 

New, Open & Save View & Principal 
Views

Shaded Undo 

Delete Transform Options Help 

Context Sensitive Help 
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Fly-out Toolbars 

A number of buttons in FeatureCAM toolbars are fly-out toolbars. Any button with a small black 
triangle in the lower right corner is a fly-out toolbar. By clicking on the triangle the menu is revealed. 
Click again to select a specific option.  The last option you picked from the fly-out menu becomes the 
current command and is displayed as a button in the toolbar.  To select this option again, just click on 
the button in the toolbar.  

 Menu Bar 
The menu bar contains all the menus of the system.  These menus contain all the commands available 
in FeatureCAM.   

Steps Toolbox 
The Steps toolbox contains an ordered list of steps for creating part programs.  Each step is a wizard 
that presents a series of dialog boxes for each process.   They are listed in the order in which you will 
use them during the process of creating a part program.   

Graphics Window 
The left-hand window is the graphics window.  This window shows the graphical representation of the 
part and the graphical toolpath simulations.   

Manufacturing Results Window 
The right-hand window is the Manufacturing Results window.  This window contains the 

Triangle reveals menu 

Current command button 

Fly-out menu 
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automatically generated documentation including tooling lists, setup sheets and the NC part programs.  
Selecting one of the tabs at the bottom of the window changes the content of this window.   

Geometry Dialog Bar 
The geometry dialog box is located under the graphics window and manufacturing results window.  
The point locations and parameters for geometry creation are entered here.   

Assistance Bar 
The Assistance bar displays step-by-step instructions for the current command.    

Status Bar 
The Status bar shows your current drawing units, tool crib, and post processor settings as well as your 
keyboard status and information about the simulation when you run one. 

The Status bar is not a toolbar, nor can it be docked.  It is the bottom part of the FeatureCAM window 
and displays information about the computer, the state of the program, or information about what your 
are doing. You can toggle it on or off in the View menu under Toolbars. 

Part View Toolbox 
The Part View toolbox provides a hierarchical view of the part.  Each setup is 
listed with each of the feature of the setup listed underneath.  From this view 
you can select, show, hide or modify features. To navigate the part view:   

1. If an object has a “+” in its left margin, click it to expand the view to 
reveal objects that are subordinate.   Click on the ”-“ to collapse the view 
and hide the subordinate objects.  Double clicking on the object also 
performs the same function.   

2. Clicking on object in the tree view will select the object in the graphics 
window.  This selection method is good for distinguishing between 
overlapping objects in the graphics window.   Make sure you click on the name and not the check 
box.  See item 4 below.   

3. Clicking on an object also reveals the  button for that feature.  Clicking on this button brings up 
menu of actions you can perform on the object.  The actions available are dependent on the object 
type.  Right clicking on the object in the tree view also reveals this menu.   
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4. Features have a checkbox.  If you uncheck the object it will be excluded from the next toolpath 
generation.   

5. By dragging a feature or setup, you can reorder these items.   

6. Double-clicking on a feature displays its Properties dialog box for editing.   

All objects are represented in the part view with the exception of geometry.   

 Part icon represents the entire part.  The part file name is also displayed in the tree view. 

 Stock icon represents the part stock. 

 Setup icon represents a setup.  The features of a setup are listed underneath a setup.  If you click on 
a setup, it changes the current setup and current UCS.   

 Feature icon represents features.  It can be a 2.5D, 3D or turn feature.   The checkbox next to the 
feature can be used to exclude it from toolpath generation.  The feature is not deleted; it is just ignored 
for toolpath generation. 

 Curve icon represents a curve in the part model.  

 Surface icon represents surfaces.  Surface milling features are classified as features, not surfaces.  

 Solid icon represents a solid.  Individual design features are listed underneath.   

 Turret icon represents a turret on a lathe.  Selecting a specific turret displays the NC code for that 
turret.   

Selecting Graphical Objects 
Many commands require you to select object in the Graphics 
window.  To select object you can: 

1. Click the left mouse button on an object.   This selects that 
object (by turning it red) and deselects any other object.   

2. Hold down the SHIFT key and click the left mouse button on 
an object.  This adds that object to the selected set of objects.  
This method allows you to select more than one object. 

3. Click the left mouse button and drag the mouse before letting up on the button.  This method is 
called box select.  As you drag the mouse, a box is displayed in the Graphics window.  All objects 
that are completely enclosed in the box are selected.  If you hold down the SHIFT key while 
selecting, the objects are added to the selected set of objects.   
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Note:  you must be in Select mode (by clicking the Select  button) to perform a selection. 

Optional Toolbars  
While the Steps toolbox and the standard toolbar are all that is necessary to run FeatureCAM, there are 
additional toolbars that can be displayed by selecting the Toolbars option from the View menu. 

Advanced Toolbar 

Show Fly-out is a fly-out menu for displaying different categories of objects . 

Hide Fly-out is a fly-out menu for hiding different categories of objects.   This does not delete the 
objects.  They are only removed from the display.  These objects can be re-shown using commands in 
the Show Fly-out.   

Curve Wizard provides a centralized interface for curve commands.  The commands available in this 
wizard are also available in the Curves and Surfaces toolbar.   

Surface Wizard presents step-by-step instructions for 3D surface construction. The commands 
available in this wizard are also available in the Curves and Surfaces toolbar.  

Solid Wizard presents solid modeling commands available in the Solid Modeling option.   

Toggle Geometry Toolbar toggles the display of the Geometry toolbar.  This toolbar contains fly-outs 
for the creation of points, lines, arcs, fillets and dimensions.   

Snap Modes displays the Snap Modes dialog.  Use this dialog to set the locations for point snapping.   

New Feature Wizard steps you through the process of creating part features.  

UCS opens the User Coordinate System dialog box for creating or changing existing UCSs.  

Show Fly-out Curve Wizard

Toggle 
Geometry 
Toolbar 

New 
Feature 
Wizard Setups 

Hide Fly-out Surface Wizard Snap modes UCS 

Solid Wizard
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Setups brings up the Setup dialog box for creating or editing part program zero.  

Snap Mode Toolbar and Dialog Box 
Entering points by coordinates is exact but not always convenient or feasible.  Picking points with the 
mouse is not always precise enough.  The bridge between the methods of point selection is snaps.  
Snapping is a CAD concept that helps you position lines, points or shapes as you construct the 
geometry of a part.  The Snap Mode bar or the Snap Mode Dialog box controls where the cursor snaps.  
What you have snapped to is displayed in the status bar.   

 

      Grid               Endpoint          Section            Centre              Object            Toolpath   

 

 

 

 

                   Point              Midpoint      Intersection       Quadrant         Tangent                 

Snap Discrimination Dialog 

Grid displays a grid and enables snapping to the grid.  Selecting Snapping Grids from the Options 
menu controls the spacing of the grid.  Grid snaps to a point on a coordinate system that is laid out on 
the stock. The grid size can be modified from the Options menu. 

Point snaps to a point object.   

Endpoint and midpoint snap to the ends and middle points of finite lines and arcs. Endpoint also 
applies to the corners of the stock. 

Section snaps equal intervals of a finite line.  The number of sections is controlled by the Sections 
parameter of the Snapping Grids dialog box.   

Intersection snaps to the intersection of lines, arcs and circles.   

Center snaps to circle centers.  This setting also controls the display of circle and arc center points.   

Quadrant snaps to the four points on a circle corresponding to 0°, 90°, 180° and 270°.   

Tangent snaps the point so that the object you are creating will be tangent to the object you snapped 
to.   
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Object snaps to a point on another object.  This includes lines of surfaces and is convenient for 
snapping points to locations on a surface.   

Toolpath snaps to points on a centerline toolpath simulation. 

Snap discrimination dialog displays a dialog box if the point you select could snap to more than one 
location. 

 

Snapping Feedback 
As you snap the cursor changes shape.  A small snap icon shadows the cursor around the graphics 
window.  The snap icon jumps to locations near the cursor.  It also changes shape in relationship to 
what it snaps to.  When snapping to a circle center, endpoint, midpoint, quadrant or section, the icon is 
a small box.  When snapping tangent to a circle or arc, the icon is a small circle that can slide along the 
circle or arc while maintaining tangency.  Snapping to a grid point, the icon is a small plus sign.  When 
snapping to an object, the icon is a large dot.   The following figure shows the cursors and icons of the 
Graphics window along with the messages displayed in the status bar.   

You can have more than one active snap mode at a time.  With snaps, it’s easy to create any geometry 
tangent to circles or arcs, pick the exact center of circles and so on. 

 

 

 

 

 

 

 

 

Drawing cursor 

Snap Icon 

Drawing cursor 

Snap Icon 

Tangent to circle “circ1” [0.75,0.75] 

Intersection of  “circ1” and “ln2”  [0.5,0.534] 
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Geometry Toolbar 
The Geometry Toolbar has a series of fly-out toolbars shown below.    

 

 
Lines Fly-out 

 

Arcs Fly-out 

 

Circles Fly-out 

 
 
 
Pick Fly-out 

 

Expand/Trim Fly-
out  

 

 

Fillets Fly-out 

Dimensions Fly-out 

 
 
Points 
Has no fly-out 
 

 
   

 Steps Toolbar 

 

The Steps Toolbox is also available as a toolbar.  It is useful to display this toolbar if you want to 
constantly view the Part View while still having the commands of the Steps Toolbox available.  See 
Chapter 2 for a description of these buttons.   
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Warping Dialog Boxes 
During graphical selections, certain dialog boxes will warp out of the way 
so that the dialog box does not cover the Graphics window.  If you click a 

button like the Pick curve  button, the dialog box warps into a single 
small title bar as shown below.   

The cursor changes into a Pick cursor .  Select the object on the screen and the 
dialog will reappear.  To cancel the pick, click on the red “X” in the small title bar.  
To disable dialog warping, uncheck Warp Dialogs in the Options menu.   

Customizing Toolbars  
The appearance and contents of the toolbars can be customized by selecting Toolbars from the View 
menu.  The Customize toolbars dialog box is displayed.   

Toolbars Tab 
This dialog box has three different purposes. 

Displaying/hiding toolbars - Check the checkbox in front a toolbar’s name to display it.  Uncheck to 
hide it.   

Changing the display of toolbars. - The appearance of the toolbars can be either flat or 3D.The size 
can be either large or small.  Large buttons are recommended for low screen resolutions or touch 
screens.   

Creating/deleting toolbars - The New button will create a new toolbar.  The Delete button will delete 
the toolbar that is selected in the list.  You can only delete toolbars that you create.  The Reset selected 
button will return the selected toolbar to its original state.  The Default toolbars button will return all 
the toolbars to their original state and delete any user-defined toolbars. 
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Commands Tab and Misc. Tab 
Clicking on the Commands tab puts the interface into 
a mode that allows you to rearrange the buttons of the 
interface.   You can drag buttons from one toolbar to 
another or drag a button from a toolbar into the 
FeatureCAM window to remove it from the toolbar.   

By clicking on one of the categories, buttons of that 
type are displayed.  Click on a button to receive a 
description.  You can drag one of these buttons onto 
any toolbar. 

The Misc. tab controls the appearance of the Steps 
toolbox and the display of the status bar and assistance 
bars. 

Display mode bar and shading mode 
By default, everything that you create in FeatureCAM is displayed as a line drawing in the graphics 
window.   Objects can also be viewed as a 2D cross section, 3D shaded or 3D hidden line drawings.  
See the chart below for the display modes that apply to specific object types and how to activate each 
type of graphics.   

Lines Line drawings apply to points, geometry, dimensions, curves, milling features, 
turning features, surfaces, solids, stock.  It is the default display mode.   

2D view Applies to stock for a turning setup and turning features.  This mode is toggled by 

clicking the 2D turned profiles  button in the display mode toolbar.   

Shaded • 3D shading applies to milling features, turning features, surfaces, solids.  There 
are a number of ways to shade and unshade objects.   

• Toggle between line drawings and shaded graphics by clicking the Shade  
button in the Standard toolbar.   

• Shade specific objects on the screen by selecting the object and clicking the 

Shade selected  button in the Display mode toolbar.  This is the only way 
to shade features.   

• Click the Unshade selected  button to return the selected object to lines or 

click the Unshade all  button to return all objects to line drawings.  These 
buttons are in the Display mode toolbar.   
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Hidden line  Hidden line graphics only apply to solids so it is best to hide all other objects and 

display only solids while in this mode.  Toggle the Hidden line  button in the 
Display mode toolbar to clip and remove the hidden lines of a solid.   

 

The following figures show a solid displayed as lines, hidden lines and shaded.   

 

Display mode toolbar 

The buttons of Display mode toolbar, control the current display mode. 

The Display mode toolbar has the following buttons to help you visualize and work with surfaces in 
the model. 

 Shade selected shades the selected entities. This gives you a solid like view of the surfaces. 

 Unshade selected removes shading from the selected entities. 

 Unshade all unshades everything that is displayed.   

 Hide shaded isoline is a toggle switch to hide or show the lines of a surface or solid while it is 
shaded.   

 Hidden line mode will display all solids as a hidden line drawing.  Note that only lines within the 
solid are hidden.  It is best to hide everything and show only the solids to use this mode.  Unclick the 
button to turn off the mode.   

Show normals displays the normals for selected surfaces in the model. 

Unshow normals hides the normals for selected surfaces in the model. 

 Turning 2D view toggles the view of a turning stage between 2D or 3D line drawing view.   
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Colors 
Different colors are different for each object type.  For example 
geometry is black and objects you select turn red.  You can change 
the default color for object types by selecting Coloring from the 
Options menu and then selecting Default colors.  The Color menu 
comes up.  Click on the new color and click OK.   

You can also change the color of any object, regardless of the object 
type, by selecting Coloring from the Options menu and then 
selecting Change selected.   
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Chapter 4 
Making Your First 2 ½ D Part 

NOTE: You must have FeatureMILL2.5D to perform this tutorial.  

This chapter is a step-by-step tutorial for building a simple part and introducing you to: 

• Creating features 

• 3D viewing 

• Generating toolpaths 

• 3D toolpath simulation 

• Automatic tool selection, feed/speed calculation 

• Dynamically generated setup documentation 

Stock Preparation 
It is assumed that you have already prepared your stock.  If you want to use FeatureCAM for this task, 
you will want to use the Face feature to face the top of the part and use a Side feature with a line as the 
profile to square an edge. 

The First Time 
1. Begin FeatureCAM by selecting FeatureCAM from the Start menu.   

The first time you run FeatureCAM, the tool database is initialized. You’ll be prompted for some 
information concerning your tool preferences and then the tool information is created based on 
your answers. 
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Create a Part File 
1. If the New Part Document Wizard is displayed, click New File, and click Next.  Click Milling 

Setup and click Inch or Millimeter depending on your preference and click Finish.   

2. If the New Part Document is not displayed, click New Part Document  button. Select Milling 
Setup and click Inch or Millimeter depending on your preference and click OK.  

3. In the Dimensions dialog box, enter 1 (25mm) for thickness, 4(100mm) for width, 5(120mm) for 
length and click Finish. Next time you use FeatureMILL it will remember the stock dimensions 
that you entered last. 

4. Click OK in the Stock Properties dialog box 

For reference, here is a dimensioned drawing of the sample part. 
English Units Metric Units 

  

4. Click the Features step  from the Steps toolbar. 

5. Select Hole and click Next. 

6. Enter  0.5 (12mm) for the Diameter and click Next.   

7. Enter 1.0 (25mm) for the X location of the hole center and 1.0 (25mm) for the Y location.  Click 
Next.   

The Strategies page is presented.  This page provides control over the types of operations that will be 
used to cut the feature.  The default operations for a hole are to spot drill and drill the hole.  If the hole 
had a chamfer, the default would be to cut the chamfer with the spot drill operation.   

8. Accept the default strategy settings by clicking Next.   

The Operations page shows a summary of the operations that will be created to cut the feature.  The 
names of the tools that have been automatically selected and the feeds and speeds are also displayed. 

9. Click on the triangle next to the Finish button and select the Finish option. 
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10. Create a rectangular pocket feature by clicking the Features step  again from the Steps 
toolbar.   

11. Select Rectangular Pocket and click Next.   

12. Accept the default dimensions by clicking Next. 

13. Enter 0.75 (15mm) for X, 2.5 (60mm) for Y and 0 for Z.  Click Next.   

14. The Strategies page indicates that rough and finish operations will be created.  Click Finish to 
accept.   

15. Use the Features step  to create a second 0.5 (12mm) diameter hole at X=4 (95mm) and Y=3 
(75mm).   

16. Use the Features step  to create another pocket just like the first, except positioned at X=2.5 
(55mm), Y=0.5 (15mm).   

Viewing 

1. So far you have been viewing the part from the top view.  Click the Isometric view button  
from the standard toolbar to get a 3-dimensional view.   
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2. The Isometric view button is actually a menu.  
Click on the triangle next to the button.  A fly-out 
menu is displayed.  Click Front to display the front 
view.  Click Isometric to return to the isometric 
view.   See Chapter 3 for more information about 
fly-out menus.   

The sample part is complete. Now the simulation features will be used to see how the part will be 
manufactured.  

Toolpaths 

Click the Toolpaths step . The Simulation toolbar is displayed. 

 

 

1. Click the 3D button and click the Play button 
to start the simulation.  If the Ordering dialog 
box appears click OK. These options will be 
covered later.     

2. A solid 3D rendering of the cutting process is 
displayed.   

ALERT! FeatureMILL runs simulations best in 
256 color mode or higher. Depending on your 
video settings, you might see a warning about 
this. You may ignore this warning for this 
tutorial. 

3. Click the Play to Next Operation  button.  The spot drill operation is displayed.  Click this 
button to view each operation until the entire part is cut.  

4. Click Eject.   The Simulation toolbar is removed from the screen. 
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Order of Manufacturing Operations 
The Op. list tab on the right side of the window shows all of the operations that the features are 

translated into. If you notice that there’s a yellow warning sign  next to an operation, this is 
FeatureCAM’s way of letting you know that there might be a problem with that operation. You can 
ignore the warnings for now.  

 

Follow these steps to see how to control the order of manufacturing in FeatureMILL. 

1. Notice on the top of the Op. list tab window the Automatic Ordering radio button is selected.  This 
means that automatic rules are being applied to order the operations.  Click the Ordering  options 

 button.   

2. Make sure that Minimize tool changes  is the only one checked and click OK. 

3. Click on the Steps toolbox and click the Toolpaths step . Click the 3D button and click the 
play button.  If the Ordering dialog box appears click OK.  You’ll notice in the simulation that it 
performs all the spot-drills, then the drills, and then the rough and finish milling for the pockets. 

4. Click the Stop  button when simulation is complete to exit simulation mode. 

5. Click the Ordering options button again. Check Do finish cuts last, uncheck everything else and 
click OK. Notice that the order of operations has changed in the Operation List. 

6. Click the Play button again. You’ll notice in the simulation that the finish cuts for the two pockets 
now are cut last. 

7. Click the Stop  button when simulation is complete. 

8. Click the Ordering options button again. Uncheck everything and click OK. Now the operations 
will have the same order as the features in the Part View. 

9. Click on the Part View tab located above the Steps toolbox.  This view shows you a list of all the 
setups and features you have created.   See Chapter 3 for details on the part view. 

10. Click rect_pock2, the last name in the Part View list, and drag it up ahead of hole2.   

11. Click the Play button again.  The second pocket is now cut as the third feature. 

12. Click the Stop  button when simulation is complete. 

So far the order of the operations is determined automatically by a set of rules. You can also specify an 
exact ordering of operations. 

13. Click the Manual Ordering radio button below the Automatic Ordering radio button. In the Fixed 
Operation Ordering dialog box that appears click OK. 
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14. Select an operation from the list and drag it either up or down.  

15. Click the Play button again. You’ll notice that the simulation now performs the operations in the 
order that you had specified. 

16. Click the Stop  button when simulation is complete. 

17. Click the Automatic Ordering radio button and click OK  

18. Click the Eject button to erase the simulation and remove the Simulation toolbar. 

Part Documentation 
Not only did the simulation model the manufacturing of the part, it also generated complete tool and 
operations lists. The tools selected are based on the tool cribs you design so you’re always sure to 
simulate what you can produce with the tools at hand. The information is already computerized and 
can be printed for use as an operator’s checklist. 

1. Click on the Details tab in the Results window.  The operation sheet looks similar to this: 
Op: 1 hole1 (spotdrill)       
Op: 2 hole1 (drill)   
Op: 3 rect_pock1 (rough1) 
Op: 4 rect_pock1 (rough2)     
Op: 5 rect_pock1 (finish) 
Op: 6 rect_pock2 (rough1) 
Op: 7 rect_pock2 (rough2)     
Op: 8 rect_pock2 (finish) 
Op: 9 hole2 (spotdrill) 
Op: 10 hole2 (drill) 

You can review this list using the scroll bars, or print it by selecting Print from the File menu. Set the 
checkboxes for what you want to print and click OK 

2. Click on the Tool List radio button at the top of the Details tab to show the Tooling list.  The Tool 
list contains all of the tools used to create the part based on the crib you have selected. The Tool 
list looks similar to this: 
 
Crib:  basic 
Summary: 
Slot 1: center_5  D 0.1875 in. 
Slot 2: TD_05000_1|2:J  D 0.5000 in. 
Slot 3: endmill0500:reg D 0.5000 in. 
Slot 4: endmill0375:reg D 0.3750 in. 
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Controlling the Automation 

1. Click on the Part View and select hole1 from the list. Click the Properties  button at the 
bottom of the screen.    

2. Click the Strategy tab.   

3. Uncheck the Spot Drill checkbox and click OK. 

4. Click the Toolpaths step . Click 3D  and click the play button.  Notice there is no spot 
drilling for that hole this time. If you look through the operations list, notice there is now only one 
spotdrill operation listed. FeatureMILL can optimize the part manufacturing process for you, but 
you control the level of automatic optimization you want. 

5. Click Eject.   

NC Code 
The purpose of FeatureMILL is to generate NC code to manufacture parts with CNC machines. After 
you have simulated the part, you can generate NC code. Before you can generate NC code for a part, 
you have to run a simulation to calculate toolpaths. If you are starting this part of the tutorial without 
having just run the simulation described above, simulate your part now. 

3. Click the NC Code step  in the Steps toolbar.    

4. Click the Display the NC code  button in the dialog box to generate the NC code.   

NOTE: If you are running an evaluation copy of FeatureMILL, a dongle, a device that attaches to the 
computer printer port, is necessary to generate NC code, or save or export files and is not 
available in the demonstration version. When you purchase FeatureMILL, a dongle is provided 
to you. 

Tool Mapping 

1. Click the NC Code step  in the Steps toolbar.   Click the Re-map the tools button  from 
the dialog box.  A dialog box is displayed shows that the tools are in the following order: 

 
TD_0500_1|2:J  1 

Endmill0500:reg  2 

Endmill0375:reg  3 

Center_5  4 

2. In this dialog box you can modify the location of the tools in the tool changer.  To move the center 
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drill to the 5th position in the tool changer, click on Center_5 in the table. 

3. Change the Tool from a 4 to a 5 in the Tool number field at the bottom of the dialog box and click 
Set.  

Note that you cannot change the number directly in the table. 

4. Click OK.   

Changing Post Processors  
1. Follow the remaining steps to change your post processor and save the NC code. 

2. From the Manufacturing menu, select Post Process. 

3. Click Browse to view the post processors. 

The default directory is c:\Program Files\FeatureCAM\M-lbry\Inch for English units. If you need 
a metric post, browse up one directory level to M-lbry. Then browse the Metric directory.  

4. Select your processor and click Open. Click OK in the Post Options dialog box. Your processor is 
now selected. Run a simulation of the part to regenerate the NC code. 

NOTE: Clicking Close will not change your post processor. 

Saving NC Code  

1. Click the NC Code step  in the Steps toolbar. Click the Save NC button  from the dialog 
box. 

2. Accept the default filename and directory and click OK.  

You are ready to machine the part. 

Saving the FeatureMILL Part 

1. Select the Save button  from the Standard toolbar.   

2. Select the directory and then type your part name.   

The Next Step 
You’re done with this tutorial and have seen the basic functions of FeatureMILL. The next section 
expands on this part by building a curve around the features. The curve is created with the layout and 
drawing tools.  
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Chapter 5 
Features From Curves 

NOTE: You must have FeatureMILL to perform this tutorial. It is recommended that you 
complete Chapter 4 before starting this tutorial. 

 

This tutorial builds on the one you just completed and introduces you to: 

1. Creating geometry (lines, arcs, fillets, etc.) 

2. Creating irregularly-shaped features 

3. Contouring around a part and adjusting where the tool plunges 

4. Open your sample part from the last chapter or if you skipped the earlier tutorial, open the 
sample2.fm file or the mtrc_gsg.fm file for metric users. If you installed in the default directory, 
these files should be in C:\Program Files\FeatureCAM\Examples\Tutorials\Features from Curves. 

Setting the Snaps 
1. Select Snapping Modes from the Options menu.   

2. Check if the following buttons are enabled, if not, click on it to enable them and turn the others 
off:  Grid points, End points, Intersections, Circle centers, Tangent to objects. A white box will 
surround a button when it’s turned on.  

3. Click OK.   

Building Circles 

1. The Principal Views button  in the Standard toolbar is a fly-out toolbar. Click the triangle 
next to the button and then click on the Top button in the fly-out toolbar.  It is usually easier to 
draw geometry in this view. (For more information about the fly-out toolbar options, refer to 
Chapter 3, Interface Tour.) 

2. Select the Geometry step  from the Steps Toolbox.  Check the Create more than one checkbox 

at the bottom of the dialog box and click the Circle from Rad, Center  button. You can move 
your mouse over an icon to read its label. 
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3. Set R in the dialog bar (below the graphics window) to 0.75 inch (20mm). 

4. Click near the center of one hole. The snap jumps to the grid at the hole’s center. If you miss the 
hole center, click Undo  (or select Undo in the Edit menu) and try again. 

5. Repeat this action for the other hole. Your part looks similar to the figure below.   

 

Drawing Lines 

1. Select the Geometry step  from the Steps Toolbox. Check the Create more than one checkbox 

at the bottom of the dialog box and click the Line from 2 pts button .   

2. For point 1 in the diagram below, click the top of the right circle.  If  the Snap Selection dialog 
box appears, select Tangent to circle and click OK. 

 

 

3. For the second point click on the upper left grid point, point 2, as shown with Xs above. 

4. Continue building lines from point 2 to point 3, from point 4 to point 5, and from point 5 to point  

5.  The completed lines look like this: 
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6. Select the Geometry step  from the Steps Toolbox. Check 
the Create more than one checkbox at the bottom of the dialog 

box and click the Corner Fillet  button.   
7. Set R in the dialog bar to 0.75 inch (20mm) 

8. Click the point marked near the upper left corner. The diagram 
on the right shows where to click to create the fillets. A corner 
fillet appears automatically trimming the lines to fit. 

9. Click the point marked near the lower right corner. A corner 
fillet appears automatically trimming the lines to fit.   

Chaining a Curve 

1. Select the Curves step  from the Steps Toolbar. 

2. Select Chain into a closed boundary  and click on the bottom line as shown.   

FeatureMILL automatically chains a closed curve and chooses a smooth path so you don’t have to 
chain all curves manually. 

Feature from a Curve 

1. With the curve still highlighted, click the Features step  from the Steps toolbox. 

2. Select Boss and click Next.   

3. The curve you selected is already selected in this dialog box.  Keep on clicking Next until you get 
to the Dimensions page of the dialog. 

4.  Set the Height to 0.75 (20mm).   

5. Click Finish.   
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Simulate the Part 
You are now ready to simulate your part.  

1. Click Isometric  from the Principal 
views fly-out.  

5. Click the Toolpaths step  from the Steps 

toolbar and click the 3D simulation  
button and then the play button.   

6. Click OK in the Ordering dialog box and the 
3D simulation is displayed in the graphics window. 

7. Click the Eject  button to clear the screen.  

Modifying the Boss Feature to Contour Around the Part 
If you watched the simulation carefully, you saw that the boss feature performed both a roughing and 
finishing operation.  To simply contour around the outer boundary of the part, you’ll need to eliminate 
the roughing operation.  The operations that are initially created for a feature are specified on the 
Strategies page of the New Feature wizard, but you can easily modify the strategy for any existing 
feature.   

1. Pick the Boss feature and click the Properties button at the bottom of the screen.   

2. The Properties dialog box comes up.  This dialog box contains the pages of the New Feature 
wizard as separate tabs.   

3. Click on the Strategy tab.  Notice that the Rough and Finish checkboxes are checked.  Uncheck 
the Rough checkbox, and click OK.   

4. Simulate the toolpaths again using the Toolpaths step .   
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Changing the Plunge Point 
The tool ramped on and off the part at the location that you chained the curve.  In this case, the tool is 
plunging on the stock.  To change the plunge point for this operation:   

1. Click on the triangle next to the Principal Views button  then click on the Top button in the 
fly-out toolbar 

2. Pick the Boss feature and click the Properties button at the bottom of the screen. 

3. The left-hand side of the dialog box contains the tree view.  It shows the feature with its operations 
listed underneath. By clicking on an operation in the tree view, you can modify an operation.   

4. Click on the finish operation in the tree view.  The tabs of the dialog box change to represent 
information specific to the operation.  Click on the Milling tab.  This tab contains the various 
attributes for changing the toolpaths that 
are generated for the operation.   

5. Click on the Plunge point(s) attribute.   

6. Click the Pick location  button that 
appears at the bottom of the dialog box.   

7. Click at a location below the part.   

Note that if you pick a location that is too 
close to the part, the plunge point is 
ignored that the toolpaths will remain 
unchanged.   

8. Click OK.   

9. Click the Toolpaths step , click the 

centerline simulation  button and the 
play button to view the changes in the toolpath. 

The Next Step 
You have completed this Tutorial.   
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Chapter 6 
Introduction to Turning 

NOTE: You must have FeatureTURN or FeatureTURN/MILL to perform these tutorials.   

If you want to evaluate FeatureTURN: 

1. Select FeatureCAM from the Start menu.  

2. From the File menu, choose Evaluation Options and make sure Turning is checked.   

3. Click OK. 

The example is a simple turned part designed to introduce you to several of the drawing and machining 
tools available in FeatureTURN.  The tutorial walks you through creating the part and introduces you 
to FeatureTURN's automation and ease of use. 

The First Time 
1. Select FeatureCAM from the Start Menu. 

The first time you run FeatureCAM, the material and tool database is initialized.  You'll be prompted 
for some information concerning your tool preferences and then the tool information is created based 
on your answers. 
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Create a Part File 
1. If the New Part Document Wizard is displayed, click New File, and click Next.  Click Turn/Mill 

and click Inch or Millimeter depending on your preference and click Finish.   

2. If the New Part Document Wizard is not displayed Click New Part Document  button. Click 
Turn/Mill and the Inch or Millimeter radio button depending on your preference.  Click OK.   

3. A Turning setup will default to a round stock.  Once in stock properties set the OD to 4 (100mm), 
Length to 5 (125mm), and ID to 0. 

4. Click on the triangle next to the Finish button and 
select the Finish and Edit properties and set Z to 
0.0625 (1.5mm) and click OK.   

5. Select Turning input modes from the Options menu. 
Make sure that 3D is checked.  

6. Select Set tool crib from the Manufacturing menu.  Click on the Tools crib and click OK.   

7. Click on the triangle of the View fly-out  on the Standard tool bar and choose Center All to 
bring your entire drawing into view.  

8. Select the Geometry step  from the Steps Toolbox. Check the Create more than one checkbox 

at the bottom of the dialog box and click the Line from 2 pts button .   On the bottom of the 
screen, type in these points to create two lines that define the OD profile: (X=2(50mm), Y=0, Z= -
3.5 (-88mm)), (X= 1 (25mm), Y=0, Z= -3.5 (-88mm)). Press ENTER. Now you should see a line 
drawn. Create a second line with the values (X=1 (25mm), Y=0, Z= -3.5 (-88mm)), (X=1 (25mm), 
Y=0, Z=0) and press ENTER.    

9. Select the Geometry step  from the Steps Toolbox and select Chamfer  from the list of 
Fillet commands. Enter width=0.25(6mm) and height=0.25(6mm) at the bottom of the screen and 
click your mouse close to the chamfer location as shown in the figure and the chamfer will snap 
into place.  Click your mouse button to place the chamfer on your drawing.  Notice how the 
chamfer automatically trims your lines. 
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Select the Geometry step   from the Steps Toolbox and click the Line from 2 pts button . Use 
the following values: (X=0.625(16mm), Y=0, Z=0), (X=0.625(16mm), Y=0, Z= -3.75 (-94mm)).   
Press the ENTER key.   

10. Select the Curves step  from the Steps Toolbar.  Click the Chain into open boundary button 

. Click on locations 1,2,3 as shown in the figure below.  Each line segment will change color 
when it is selected.  Name this curve "Turn" and press the  ENTER  key.   

11. Select the Curves step  from the Steps Toolbar.  Click the Chain into open boundary button 

. Chain the Bore ID curve by clicking on locations 4 and 5.  Label it "Bore" and press the 
ENTER key. Your drawing should look like the one below. 

 

Making Features 

The 2D Turned Profiles  button is located on the display mode toolbar and will simplify the 
screen.  Annotations have been added below to show the 7 features that make up the part. 
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1. Click Features step  from the Steps Toolbar.   

Note:  For Turn/Mill users only, an extra form will pop up asking the user to choose Turning or 
Turn/Mill. If this appears select Turning. 

 

2. On the New Feature form, select Turn and click Next.   

3. You will now pick the curve graphically.  Click on the Pick Curve button .  The dialog box 
will warp to reveal the Graphics window beneath.  Click on the curve you named “Turn” earlier.  
Since this pick could be either the curve or the line you may see the Select dialog box.  This box 
helps to clarify a pick.  In this case, select “Turn” from the list and click OK and then click Next in 
the New Feature – Curve dialog box.   

4. Accept the default strategy settings by clicking Finish. 

5. Create a Facing Feature by clicking the Features step  from the Steps Toolbar.   

6. Click Face and click Next.    

7. Set Outer Diameter to 4 (100mm), Inner Diameter to 0, Thickness to 0.0625 (1.5mm).  Note that a 
face feature automatically knows the OD and ID values from the stock properties.  Click Finish to 
accept the default values for the rest of the dialog boxes.   

8.  Click the Toolpaths step  in the Steps Toolbox. The Simulation toolbar is displayed. 

 

 

 

9. Click the 3D button and the Play button.  Click OK in the Ordering dialog if it appears.  The 
following simulation is displayed.  Click the Eject button to return to the drawing view. 

10. Use the Features step  from the Steps Toolbar to create a hole.  On the Dimensions page set 
the Diameter to 1.0 (24mm), Depth to 3.75 (94mm). Click Next and set Z to 0 and click Finish. 

11. Create a bore feature by using the same process you used to create the turn feature.  Use the curve 
you named “Bore”.    

12. Click on the triangle of the Principal views fly-out 

 on the Standard tool bar and click on the 
Isometric button from the fly-out to see an isometric view 
of your part. 
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13. Click the Toolpaths button  in the Steps toolbox and view a 3D simulation by clicking the 3D 
button and the Play button.  Click the Eject button to clear the screen   

14. Return to the Principal Views fly-out and select Top to return to the original view. 

15. Click the Features step  and select the Groove radio button in the From Dimensions group. 
On the Dimensions page set Location to ID, Orientation to X-axis, Diameter to 1.25 (31mm), 
Depth to 0.125 (3mm), Width to 0.250(6mm), Leave the other settings at 0. Click Next and set Z to 
–3 (-75mm). Click Finish. 

16. Use the Features step  and select the Thread radio 
button in the From Dimensions groups.  On the 
Dimension page, check Get the dimensions from a 
standard thread, click OD  and select the 2.0000-
4.5UNC (M50-15 for metric) thread.   Click Next.   

17. On the Dimensions page set Thread to Right Hand, 
Thread Length to 1.0 (24mm).  Click Finish. 

18. Click the Toolpaths step  in the Steps toolbox and 
view a 2D simulation by clicking the 2D button and 
the Play button.  Click the Eject button to clear the screen.   

19. Use the Features step  to make a Cutoff Feature. On the Dimensions page set Diameter to 
4(100mm), Inner Diameter to 0, Width to 0.122 (3mm), Click Next and set Z to -4.5 (-112mm).  
Click Finish. 

The sample part is complete.  Watch a 2D simulation followed by a 3D simulation to view the finished 
part. 
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Ordering of Operations 
You can control the ordering of operations by modifying the Turn Operation Template.  This template 
lists the manufacturing order of the various turning features.    

1. Click the Ordering option  button on the Op. List tab in the Results window.   

2. The Automatic ordering option dialog box comes up.  Click on the Use template radio button and 
click the Edit template button.   

3. The default order is shown on the left.  Click on Rough OD Turn and click the down arrow until it 
is located under the Finish ID Turn operation.  Click on Finish OD TURN and click the down 
arrow until it is located under Finish ID Turn.  Click OK  twice.   

4. Simulate the toolpaths and you’ll notice that the OD roughing and finishing now happen after the 
hole is drilled.   

Part Documentation 
FeatureTURN will automatically generate a Manufacturing Operation sheet and a Tool list.  The 
Manufacturing Operation sheet appears by default in the Results window.  It contains information such 
as machining time, tools selected, feeds and speeds, and horsepower requirements for the various 
operations.  A Tool list is also created that gives all the specification and slot assignments for the tools 
used to manufacture your part.   

1. Click on the Details tab at the bottom of the Results window.  Each operation of the process plan 
is listed in order.   

2. Click on the Tool List radio button at the top of the Details tab.  Now the tool list is presented in 
the Results window.  This document provides a summary of all the tools required for the job as 
well as details of each tool.   

You can print this documentation by selecting Print from the File menu.   
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NC Code 
After you have simulated the part, you can generate NC code. FeatureTURN comes with many post 
processors and the ability to create custom post processors as well. 

Before you can generate NC code for a part, you have to run a simulation to calculate toolpaths. If you 
are starting this part of the tutorial without having just run the simulation described above, simulate 
your part now. 

1. Click the NC code step  in the Steps toolbar.    

2. Click the Display the NC code  button in the dialog box to generate the NC code.   

NOTE: If you are running an evaluation copy of FeatureTURN, a dongle, a device that 
attaches to the computer printer port, is necessary to generate NC code, or save or 
export files and is not available in the demonstration version. When you purchase 
FeatureTURN, a dongle is provided to you. 

Changing Post Processors and Saving NC Code  
1. If you are running FeatureTURN, default post processor is for a Bridgeport machine. Follow the 

remaining steps to change your post processor and save the NC code. 

2. From the Manufacturing menu, select Post Process. 

3. Click Browse to view the post processors. 

4. The default directory is c:\Program Files\FeatureCAM\T-lbry\Inch for English units. If you need a 
metric post, browse up one directory level to M-lbry. Then browse the Metric directory.  

5. Select your processor and click Open. Click OK in the Post Options dialog box. Your processor is 
now selected. Run a simulation of the part to regenerate the NC code. 

NOTE: Clicking Close will not change your post processor.  

6. Click the NC code step  in the Steps toolbar.   Click the Save NC button  from the dialog 
box. 

7. Accept the default filename and directory and click OK.   

You are ready to machine the part. 

Saving the FeatureTURN Part 

1. Select the Save button  from the Standard toolbar.   

2. Select the directory and then type your part name and click OK.   
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The Next Step 
You have completed this tutorial. 
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Chapter 7 
Advanced Turning and 

Machine Simulation 
NOTE: You must have FeatureTURN, Multi-turret Turning and Machine Simulation to 

perform this tutorial.   

This chapter introduces you to: 

• Creating subspindles 

• Using Machine simulation 

• Setting up a second turret 

• Synchronizing operations 

 

Getting Started 
All files for this tutorial are located in \Examples\Tutorials\Multi-turret Turning\ where you 



Advanced Turning and Machine Simulation 

 58 

installed FeatureCAM. If you installed the program in the default directory, these files should be in 
C:\Program Files\FeatureCAM\Examples\Tutorials\Multi-turret Turning\. 

1. Open the tutorial file twinturret_tutorial.fm  

Setup Machine Simulation  
1. Select Toolbars from the View menu.  Make sure that Advanced option is checked and click OK.   

Click the Setups  button from the Advanced toolbar.   

2. Select Setup1 from the drop-down list and click Edit.  Keep clicking Next until you get to the 
Setup - Simulation information page. 

3. Click the Browse  button and locate c:\Program Files\FeatureCAM\Examples\ 
Tutorials\Multi-turret Turning\TURNING_INDEX_G200.md.  

4. Select the file and click Open. 

5. Click Finish and then click Close in the Setups dialog box. 

6. From the Manufacturing menu, select Post Process. 

7. Click Browse to view the post processors. 

8. Go to the directory c:\Program Files\FeatureCAM\Examples\Tutorials\Multi-turret Turning\. 

9. Select the Moriseiki with Mitsubishi Mill-turn upper and lower example.CNC processor and click 
Open.  

10. Enter X = 18 and Z =0 for the Tool Change Location. Click OK. Your processor is now selected 
and the tool change location is set. 

11. Click the Toolpaths step  in the Steps 
Toolbox to bring up the simulation toolbar. 

12. Click the Machine simulation  button 

and then click the Single Step  button. 
Click OK if the Ordering dialog box 
appears. You should now see the machine 
displayed on your screen.  

13. Click the right mouse button in the 
graphics window to bring up the View fly-
out menu. Use the viewing options to get a good view of the machine. 



Advanced Turning and Machine Simulation 

 59

14. Click the Play button. You should now see the machine parts moving and cutting the part. 

You can use the options in the View fly-out menu during the simulation to get a better view without 
pausing the simulation. 

15.  Click the Eject button. 

Add a Subspindle Feature 
So far we have been dealing with a single spindle. Now we’ll introduce a second spindle, or a 
subspindle, to our setup. 

1. Click on the Part View above the Steps Toolbar. 

2. Notice that we have a number of spindle features already created: 
main_off 
sub_off 
sub_open_and_drop 
sub_pos_in 
sub_close 
main_on_sync 
sub_on_sync 

3. Select Setup1 from the list. 

4. Select the Features  step from the Steps Toolbar. 

5. If the New Feature – Type dialog box is displayed, select Turning and click Next.   

6. Select Subspindle and click Next. 

7. Select Sub Spindle and Position the spindle radio buttons and click Next.   

8. Check the Send the subspindle home checkbox and click Finish. If the Sub Spindle Properties 
dialog box appears click OK. 

9. Click on Part View and notice the new subspindle feature added to the end of the list under the 
label Setup1. 

10. Select the new subspindle feature from the Part View list and right click. Select Rename and type 
in “sub_home” as the new name. Now all the subspindle moves are complete. 

Add a Bar Feed Feature  

1. Select Setup1 from the Part View and select the Features   step from the Steps Toolbar. 

2. If the New Feature – Type dialog box is displayed, select Turning and click Next.   

3. Select Bar Feed and click Next. 
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4. Enter 3.0 for Diameter and 4.2 for Feed Amount. Click on the down arrow next to the Finish 
button and select the Finish and Edit Properties option. 

5. Enter –4.2 for the Z location and click OK. 

Run Subspindle Simulation 
1. Click on Part View and check all the boxes that are unchecked in all the setups. All the 

checkboxes in the Part View should now be checked. 

2. Click on the Op List tab at the bottom of the Results window. 

3. Point your mouse over the Operations column header and click the right mouse button. This will 
bring up a fly-out menu.  

 

4. Check the Show Setup option. This will display a new column in the Operation List called Setup 
Name. This column lets you know which spindle will be used to run an operation. 

Notice that all the features listed under Setup1 in the Part View have the setup name of Main spindle in 
the Operation List. These features will be cut on the main spindle of the machine. Features listed under 
Setup2 will be cut on the subspindle. 

5. Hold down the CTRL key and select the last two operations in the Operation List. While still 
holding down the CTRL key, drag the lines up and place them right below the cutoff operation. 

6. Click the Toolpaths step  in the Steps Toolbox. Click the Machine simulation  button 
and click Play. You should now see the machine parts moving and cutting the part on both the 
main spindle and the subspindle. 

Notice that the operations were simulated twice. This is done to show how production turning works. 
This feature will become more apparent at the end of this tutorial. 

7. Click the Eject button. 
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Setup Second Turret 
1. Click on the Op List tab in the Results window. 

2. Point your mouse over the Operations 
column header and click the right mouse 
button. Check the Show Turret option. 
This will display the turret number to the 
left of the tool name. 

3. Shift select all the operations in the Operations List that are on the Sub Spindle (select the first 
subspindle operation, hold down the SHIFT key and select the last operation). 

4. Click the right mouse button and select the Set opers to ‘Lower turret’ option. Notice that now the 
turret number for those operations has changed from P1 to P2. These operations will now run on 
the machine’s second or lower turret. 

5. Click the Turrets tab in the Results window. Here you can see the turret and spindle that each 
operation is associated with and the total time for cutting the part. 

6. Click on the Timeline that appears at the top of the Turrets window and drag it left and right while 
holding down the left mouse button to make it shorter or longer.   

Synchronize Operations 
1. Select the last hole drill operation block in the Sub Spindle section (You may need to extend the 

timeline to view the operation). 

2. Hold down the CTRL key and select on the main_off operation block in the Main spindle section ( 
You can move your mouse over an operation block to 
display the name of the operation) 

3. Click the right mouse button and select the option Set 
sync for ‘radial_pattern1.hole2.drill’ before 
‘main_off.Main spindle off’.  

4. Notice that now the operations have been shifted and a 
new synchronization point is set. The main_off 
operation will now happen after the drill operation.  

5. Select the bore2 finish operation in the Main spindle 
section. 

6. Hold down the CTRL key and select the bore1 rough pass 1 operation block in the Sub Spindle 
section. 

7. Click the right mouse button and select the option Set sync for ‘bore2.finish’ before ‘bore1.rough 



Advanced Turning and Machine Simulation 

 62 

pass 1’. 

Now there should be a total of two synchronization points set. 

Run Synchronized Multi-Turret Simulation 

1. Click the Toolpaths step  in the Steps Toolbox. Click the Machine simulation  button 
and click Play.  

2. Notice that now both turrets are running in a synchronized fashion based on the synchronization 
points that we set earlier. 

3. Click the Eject button  

The Next Step 
 

 You have completed this tutorial.   
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Chapter 8 
Creating a Turn/Mill Part 

NOTE: You must have licensed the Turn/Mill option to run this tutorial.   

This tutorial is only available in inch units. 

In this tutorial you will learn to: 

• Create parts for lathes with milling capabilities 

• Mix turning and milling features 

• Create milling features on the OD and face of the part 

• Accurately simulate a turn/mill part 

The following part will be created in this tutorial: 

 

Getting Started 
1. Start FeatureCAM.   

2. Click New Part Document  button.   

3. Click on Turn/Mill, click Inch and click OK.   
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4. In the stock dialog enter 3 for the OD, 2 for the Length and 0 for the ID and click Finish.  (if this 
dialog box does not display automatically, click the Stock step from the Steps toolbox). Click OK 
in the Stock Properties dialog box if it appears.  

5. From the Options menu select Turning Input Modes and check Diameter.   

Creating a Turned Feature 

1. Select the Geometry step  from the Steps Toolbox and click 

the Connected Lines button .  .   

2. On the bottom of the screen, type in these points to create two 
lines that define the OD profile: (D1=2.5, Z1= 0), (D2=2.5, Z= 
-1.5). Press ENTER. Type the values (D2=2.75, Z= -1.5).  Press 
ENTER.  Type (D2=2.75, Z=-2.0) and press ENTER.    

3. Select the Geometry step  from the Steps Toolbox and click 

the Corner fillet button . 

4. Enter 0.125 as the radius at the bottom of the screen and click at 
the location labeled as Corner radius in the figure.   

5. Select the Curves step  from the Steps Toolbar.  Click the 

Chain into open boundary button . Click on the locations 
labeled 1 and 2 in the figure.  Click ENTER.   

6. Select the Features step  from the Steps Toolbar.   

7. Click Turning and click Next. 

8. Click Turn and click Finish.   

9. Click Isometric  from the Principal Views fly-out.   

10. Click the 2D turned profiles  button in the display mode toolbar to turn on 3D line drawing 
view. For details on the Display mode toolbar, see (Chapter 3, Interface Tour).  
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Creating a Radial Pattern on the Face 

1. Select the Features step  from the Steps Toolbar.   

2. Click Turn/Mill and click Next.   

3. Click Hole and Make pattern from this feature and click Next.   

4. Enter 1.0 for the Depth, 0.0 for the Chamfer and 0.25 for the 
Diameter and click Next.   

5. Click Radial and click Next.   

6. Enter 3.0 for the Number, 2.0 for the Diameter, 120 for the Spacing Angle, 60 for the Angle and 
click Axial for the Feature Orientation and click Finish. 

Engraving on the Face 

1. Select the Curves step  from the Steps Toolbar and select the 

Create curves using curve wizard  button.   

2. Click Other methods, click Text and click Next.   

3. Enter TURNMILL as the Text, click Linear as the Type. Enter (0.0,  
-0.045 ,0.0) as the X, Y and Z locations.  Enter –90 as the Angle.  
Enter Center as the Justification, Enter 0.4 and 0.4 as the X and Y 
Scaling. 

4. Click Font and select Machine Tool Gothic for the font type and 72 for 
the font size. Click OK and then Finish.   

5. Select the text string in the graphics window and click the Features 

step  from the Steps Toolbar.   

6. Select Turn/Mill and click Next.   

7. Select Groove and click Next until you get to the Dimensions page of the dialog box. 

8. On the Dimensions page, enter 0.0625 as the Width, click Simple and Face, and enter 0.02 as the 
Depth.   

9. Click Finish.   
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Creating a Pattern of Wrapped Slots 

1. Select the Features step  from the Steps Toolbar.   

2. Click Turn/Mill and click Next.   

3. Click Slot and Make pattern from this feature and click Next.   

4. Set Length to 1.0, Width to 0.5, Depth to 0.25 and click Next. 

5. Select Radial and click Next. 

6. Set Number to 3, Diameter to 2.5, Spacing Angle to 120, Angle to 120 and Feature Orientation to 
Radial.  Click Next.   

7. Set Z to 0.25.   

8. Click the triangle located in the Finish button and click 
Finish and Edit Properties.  This brings up the 
properties dialog box for the pattern and allows us to 
change some additional attributes.   

9. Click Wrap feature around Z axis and click OK.   

Simulating a Turn/Mill Part 

1. Click the Toolpaths step  in the Steps Toolbox. The Simulation 
toolbar is displayed. 

2. Click the 3D simulation  button and click Play .  Notice how the 
toolpaths are accurately simulated including the part rotations.   

3. Click Eject  at the completion of the simulation 

The Next Step 
You have completed this tutorial.  If you want to see other examples of turn/mill parts, look in the 
examples/turnmill directory.  
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Chapter 9 
Features from 3D CAD 

Models 
NOTE: You must have FeatureMILL with the FeatureRECOGNITION option or 

FeatureMILL3D to perform this tutorial.  

This tutorial is only available in metric units.   The part will be recognized twice, first using the AFR 
wizard and second using other feature recognition techniques.   

In this tutorial you will learn to: 

• Import 3D models 

• Dynamically shade 3D models 

• Create features directly from 3D solid models using both automatic feature recognition and more 
interactive methods.   
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Tool Cribs  
You must have metric tooling loaded to perform this tutorial.  If you do not have metric tools in your 
database: 

1. Exit FeatureCAM by selecting Exit from the File menu. 

2. Click on the Start menu.  Click on Programs (or All Programs).  Select InitDB from the 
FeatureCAM program group.  Or you can run Initdb.exe from the program directory where 
FeatureCAM is installed. 

3. Select On my local computer and click Next. 

4. Select Both and click Next. 

5. Answer the questions of the wizard and click Finish at the end.   

Importing the CAD Model 
1. Start FeatureCAM.   

2. Click New Part Document  button.   

3. Click on Milling Setup, click Millimeter and click OK.   

4. In the Dimensions dialog box, click Finish.  Click OK if the Stock Properties dialog appears. 

5. Select Import/export options from the File menu.   Check Import SAT, SLDPRT, MOD, DXF & 
X_T as solids. Check Center stock automatically and click OK.   

6. Select Import from the File menu and browse to C:\Program 
Files\FeatureCAM\Examples\Tutorials\3D models. 

7. Select files of type ACIS and select Tutor9.sat and click Open. 

8. Select Use the wizard option in the Import Results dialog box and keep clicking Next until you get 
to the Stock Dimensions  page. 

9. Select Compute stock size from the size of the part and click Finish. The stock is now resized. 

10. Click on the Part view.  Click on the “+” next to the Solids category.  Notice that solid1 is listed.  
This is the solid model you just imported.  Click back onto the Steps toolbox.     

11. Click Isometric  from the Principal Views fly-out.  You’ll notice that the stock has been 
resized but the setup is located at the center of the stock.  
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12. Click the Setups  button from the Advanced toolbar.   

13. Click Edit and click Next.   

14. Select Align to Stock Face and click Next.   

15. Click the  button on the lower left end of the stock picture.   

16. Click Finish and click Close. The stock has now been aligned to the stock face. 

17. Select Set tool crib from the Manufacturing menu.  Click on the tools crib and click OK.  Notice at 
the bottom of the window, in the Status bar the current tool crib has been changed to tools. 

Shade the Part 

1. Click the Shade  button.   

2. This shaded view makes it easier to see the cavities in the model.  Remember, at this point the part 
model contains only surfaces.   

3. Toggle the Shade button to turn off the shading.   

Automatic Feature Recognition 
This entire part can be automatically recognized using the automatic feature recognition (AFR) wizard.   

1. Click the AFR step  from the Steps Toolbar. 

2. Click the Next button twice. 

3. The features that were just recognized are listed.  Click the Finish button.   

4. Click the Toolpaths step  in the Steps Toolbox. The Simulation toolbar is displayed. 

5. Click the 3D simulation  button and click Play . If the Ordering dialog box appears, click 
OK. 

6. Click the Eject  button.   

Note that all features of the model were automatically recognized and the part is ready to cut.  
With many parts automatic feature recognition is all you need to program your part, but with 
others, you may need to use some of the other feature recognition techniques.   
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For the sake of demonstration you will remove the features you just created and reprogram 
them using additional feature recognition techniques.   

7. Click the Undo  button to remove the features you created so far.   

Recognize All Holes Using Another Method 

1. Select the Features step  from the Steps Toolbar.   

2. Click Hole and Extract with FeatureRECOGNITION and 
click Next.   

3. Click Recognize and construct multiple holes and click 
Next.    

4. The holes that are automatically recognized are shown on 
the screen.  Three holes were recognized along with the 
circular pocket in the middle.  We want to ignore the 
center pocket, so select the three other holes with the 
mouse and click Finish.   

5. Click OK if the Pattern Properties dialog box appears. The three holes have now been recognized.    

6. Click the Ordering options  button in the Op. list tab.   

7. Click on Cut higher operations first, Minimize tool changes 
and Minimize rapid distance.  Click OK.   

8. Click the Toolpaths step  in the Steps Toolbox. The 
Simulation toolbar is displayed. 

9. Click the 3D simulation  button and click Play  

10. Click the Eject  button.   

Recognizing All Pockets Automatically 

1. Select the Features step  from the Steps Toolbar.  

2. Click Pocket and Extract with FeatureRECOGNITION and click Next.  

3. Click Automatic recognition and click Next.   



Features from 3D CAD Models 

 71

4. Click Select all and click Finish.    

5. Click the Toolpaths step  in the Steps Toolbox. The 
Simulation toolbar is displayed. 

6. Click the 3D simulation  button and click Play . 

7. Click the Eject  button.     

Create a Slot Feature Using the Pick Surface  Button 

1. Select the Features step  from the Steps Toolbar. 

2. Click Slot and Extract with FeatureRECOGNITION. 

3. Click Next.   

4. Click the Pick surface  button and click on 
location 1.  If the Select dialog box comes up, select 
the name that corresponds to the surface at location 
1 and click OK.  (The surfaces are highlighted in the 
graphics window as you select the names.)   

5. Click the Pick surface button again and click on 
location 2. Select the surface from the Select dialog 
box and click OK.   

6. Click Next and review the extracted slot dimensions 
and click Finish.   

Create a Side Feature 
1. Select Top from the Principal Views fly-out. 

2. Drag-select the region shown below. 
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3. Select Isometric from the Principal Views fly-out. 

4. Click the Shade  button to turn on shading. The shaded view will make it easier to select faces 
on the surface. 

5. Hold down the SHIFT key and click on the side of the hole pattern that is selected as shown in the 
image. This will remove the hole pattern from the 
selected group. 

6. Select the Features step  from the Steps Toolbar. 

7. Click Side and Extract with FeatureRECOGNITION and 
click Next.   

8. Click Select side surfaces and click Next. 

9. Click Next. 

10. If the blue arrow is pointing to the inside of the part, click 
the Reverse side  button until the blue arrow points to 
the outside of the part. 

11. Click Finish. 

Simulate the Entire Part 

1. Click the Toolpaths step  in the Steps Toolbox. 
The Simulation toolbar is displayed. 

2. Click the 3D simulation  button and click Play 

.   

3. Click Eject  at the completion of the simulation.   

 

The Next Step 
The features for the entire part have been created directly from the surfaces of the solid model.  Using 
FeatureCAM’s feature-based manufacturing automation, this part can be created quickly and easily.   
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Chapter 10 
Introduction to 3D 

NOTE: You must have FeatureMILL3D to perform the examples in this chapter. These 
examples are only specified in inch units. You must have the basic tool crib installed.  

This example introduces: 

• Modeling 3D surfaces 

• Manufacturing surfaces using surface milling features 

• Manufacturing operations 

• Tool selection 

• 3D manufacturing attributes 

In this example you will model and create manufacturing toolpaths for the following part. 
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Introduction to 3D Modeling 
1. Start FeatureCAM.   

2. Click New Part Document  button. 

3. Click on Milling Setup, click Inch and click OK.   

4. In the Dimensions dialog box, click Block and set Width to 3, Length to 6.25 and Thickness to 2.0.  

5. Click Finish.   

6. Select Toolbars from the View menu.  
On the Toolbars tab, make sure that 
Geometry and Advanced are checked and 
click OK.   

7. Click on the lines fly-out menu and 
select Vertical.   

8. On the bottom of the screen, type in 1.0 
for X, 0.0 for Z and press the ENTER 
key.   

9. Create two more lines at X= 5.25 and X = 
6.0. 

10. Click on the lines fly-out and select 
Horizontal.  Create horizontal lines at Y= 
0.5, 1.125, and 1.5.   

11. Click on the lines fly-out menu and select 
Line at Angle thru Pt.. Type 30 as the angle and click at the intersection labeled Pt Angle Location 
in the figure.   

12. Click on the arc fly-out menu and select 
Arc from Radius, 2Pts.  Enter 0.5 as the 
radius and click on locations 1 and 2.     

13. Create another arc of radius 1.0 and click 
at location 3 and 4.  Create another arc of 
radius 1.0 at locations 5 and 6.     

14. Select the Curves step  from the 
Steps Toolbox.  Select Chain pieces into 

an open…  button.   Click at the locations 7 and 8.  
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Create the Bottle Surface 

1. Click the Surfaces step  from the Steps 
Toolbox.   

2. Click Surface of Revolution and click Next.   

3. Click the Pick curve  button and select the 
curve you chained. 

4. Enter 0.0 for Start angle, and 180 for End angle. 

5. Click the Pick line  button and select the top 
horizontal line (the one at Y=1.5).     

6. Click Finish.   

7. Click Isometric  from the Principal Views fly-out. 

To control how the part is displayed you can change the values in the Viewing Options dialog box. 

8. Select Viewing… from the Options menu.  

9. Uncheck the Show surface boundaries only checkbox and hit Apply. You should now see your part 
drawn with lines in the interior of the surface. For large models, this option will make the display 
of the part slower.  

10. Enter 20 for Wireframe and hit Apply. The surface will now be drawn with more lines. Decreasing 
the value of Surface fineness will improve the display quality but can slow down the graphics. 

11. Select Hide All Geometry from the Hide  fly-out.   

Introduction to 3D Manufacturing 

1. Click on the Select  button.   

2. Select the surface. 

3. Click the Features step .   

4. Select the Surface Milling radio button.   

5. Click Next twice to get to the New Strategy page of the dialog box. 
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6. Click Choose rough, semi finish, and finish … and click Next.   

7. Click Z level rough and click Next. 

8. Select None and click Next.   

9. Select Isoline and click Finish and Edit.   

10. Click on Z level in the tree view. 

11. Select the Strategy tab and check Classify slices as pocket. 

Simulating the Entire Part 

1. Click the Toolpaths step  in the Steps Toolbox. The Simulation toolbar is displayed. 

2. Click the 3D simulation  button and click Play .   

3. Click Eject  at the completion of the simulation 

 

 

 

 

 

 
 
 

The Next Step 
You have completed this tutorial and can move to the next chapter for more advanced 3D 
manufacturing techniques.  



   

 77

 

Chapter 11 
Advanced 3D Milling 

NOTE: You must have FeatureMILL3D to perform this tutorial. 

In this example you will import a 3D IGES surface model and create 4 different types of toolpaths for 
manufacturing the part.   

Import the Part 

1. Click the New Part Document  button. 

2. Click Milling Setup, Inch, and click OK.   

3. Click Finish in the Dimensions dialog box.  If the Stock Properties dialog box appears click OK. 

4. Select Import/Export Options from the File menu. 

5. Check Center stock automatically and click OK.   
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6. Select Import from the File menu.   

7. Select IGES as Files of type.   

8. Select phone.igs from c:\Program Files\FeatureCAM\examples\3D and click Open. 

9. Click No in the pop-up window. 

10. Select the Use the wizard option in the Import Results dialog box and keep clicking Next until you 
get to the Stock Dimensions page. 

11. Click Compute stock size from the size of the part, and click Finish. 

Create the 3D Strategy  

1. Click on the Isometric  button from the Principal views fly-out.   

2. Select Select all from the Edit menu. 

3. Select the Features step  from the Steps Toolbar. 

4. Click Surface Milling and click Next twice.   

5. Click Choose rough, semi finish, and finish … and click Next.   

6. Click Z level rough.   

7. Check Flat surface support and click Next. 

8. Select Z Semi and click Next.   

9. Select Z Level and click on the triangle next to the Finish button and select the Finish and Edit 
Properties option. 

10. Select the second z-level operation in the list. 

11. Check the Interleave spiral paths checkbox and click OK. 

12. Click on Manufacturing and select Post Process. 

13. Change the Tool Change Location Z to be 2.0 

14. Press OK. 
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Simulating the Toolpaths  

1. Click the Toolpaths step  in the Steps Toolbox. The Simulation toolbar is displayed. 

2. Click the Centerline simulation  button and click Play .   

3. Click the Erase  button to temporarily clear the screen.   

4. Click on the Op List tab in the Results window. 

5. Select the first operation in the Operations List and click the Preview toolpaths  button. 

6. Click the Play Selected  button from the simulation toolbar to see the toolpath for this 
operation. 

7. Click on the different operations and click the Play Selected button to see the different 
simulations.  

 

Z Rough 

 

Z Semi Finish 
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Z Level Interleave 

Clean Up the Fillets 

1. Click on Part View. Select srf_mill1 from the list and click the Properties  button at the 
bottom of the screen 

2. Click the Process tab.   

3. Click the Add new operation  button.  Click Pencil and click Next.    

4. Click the Finish radio button  

5. Click on the finish3 process in the tree view 

6. Select tooling and then select a 0.25 diameter Ball 
endmill. 

7. Click the Finish button at the bottom of the dialog box. 

8. Click the Preview toolpaths   button in the 
Operations List portion of the Manufacturing Results 
window.  The dialog box will warp. 

9. Click the Play selected  button in the simulation toolbar.  A single toolpath is created along 
the fillet. Note that this operation takes some time to calculate.   

10. Click the Stop  button. 
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The Next Step 
You have completed this tutorial. In addition the machining strategies used above, FeatureCAM has 
the following finishing strategies: 

 

Parallel Machining 

The Parallel machining strategy 
machines the part in a series of 
parallel passes at a specified angle 
and stepover. A second 
perpendicular pass can be applied 
to improve surface finish in steep 
areas. 

 
 

 

Radial and Spiral Machining 

The Radial machining strategy machines a 
part with a series of passes which radiate 
from a center point. Spiral machining 
machines the part with a single continuous 
spiral pass. In the example to the right the 
outer area has been machined with the 
Radial strategy, the center area using 
Spiral. 
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Flowline Machining 

In this strategy a control surface is used to guide the direction of machining. This enables the 
production of toolpaths with an exceptional level of control over surface finish. With suitable cutters it 
is possible to use the flowline strategy to machine undercuts without the use of a 5 axis machinetool. 

 

 

 

 

 

 

 

 

 

 

Flowline machining of a blowmold part 

 

 

                    

 

      

 

 

 

 

Flowline machining of an undercut feature  
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Isoline Machining 

In this strategy each surface on a part is machined in a user defined direction. This gives a great level 
of control over the surface finish and tool loading. The example below shows a jug mold which has 
been machined using the Isoline strategy. Note how the cutting direction on each surface has been 
chosen to give the best finish.  
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Four Axis Machining 

FeatureCAM rotary machining allows the user to generate four axis toopaths for finish machining. The 
tool moves in 3 axes whilst the workpiece rotates around a rotary axis. Rotary moves may be indexing 
or continuous. 

 

 

 

 

 

 

 

 

 

 

For further information about all of the above strategies please download 
the advanced 3D machining tutorials from our website: 

www.featurecam.com 
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Chapter 12 
Solid Modeling 

Note:  You must have the Solid Modeling Option to perform this tutorial.    

This tutorial introduces you to the solid modeling capabilities of FeatureCAM by creating a model of 
the simple computer speaker shown below.   The tutorial is available only in metric units and 
introduces you to:   

• Extrude design features 

• Hidden line graphics 

• Loft design features 

• Filleting solid models 

• Core/cavity separation of a solid model 

• Creating manufacturing features from solids 

Getting Started 

1. Click New Part Document  button.   

2. Click on Milling Setup, click Millimeter and click OK. 

3. Click Finish in the Dimensions dialog box. 

4. If the stock dialog box is displayed, click OK.   

5. Turn on the necessary toolbars by selecting Toolbars from the View menu.  Check the Steps, 
Display Mode and Solid checkboxes on the Toolbars tab and click OK.     
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Create the Initial Solid 

1. Click on the Curves step from the Steps Toolbar and click on the Curve wizard . 

2. Select Other methods as the method and Rectangle as the constructor.  Click Next.   

3. Click the Use corner, width and height radio button and enter 0.0 and 0.0 for the X and Y Corner 
coordinates.   

4. Set Width to 100 and Height to 65.  Check Create as arcs and lines and click Finish.   

5. Click on the vertical line on the right and click the Delete  button.   

6. Select Snapping modes from the Options menu.  Make sure the 
End points button is pressed and click OK.  (A pressed button will        
have a white square around it) 

7. Select the Geometry  step  from the Steps toolbar. Click the 

Arc from Radius, 2 Pts  button.   

8. Enter a Radius of 105 and click on the two open end points where the deleted vertical line 
connected.   

9. Select the Curves step  from the Steps Toolbar. 

10. Select Chain into a closed boundary  and click on the arc you just created.  Click the Create 
button at the bottom of the screen.   

11. Click the Solid Wizard  button from the Advanced toolbar.   

12. Click Define a custom shape and click Next.   

13. Select From curves as the method and Extrude as the constructor and click Next.   

14. Enter –50 as the Vector Z coordinate and –5 as the Draft Angle and 
click Finish.   

15. Click on the Part view on the left side of the screen.  The Solid 
category now has a “+” next to it.  Click on the “+” to reveal the solid, 
called solid4.  That is the name of the solid we are creating.   The 
number following the solid name may be different for you. 

16. Click on the “+” next to solid4.  This reveals the features that make up 
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the solid.  There is only one feature called extbase1, a base feature is the initial feature for a solid.   

 

Hidden Line Graphics 
With solids there are additional graphics options available.  By default, you 
are in line drawing mode.  With solids, hidden line graphics are available.   

1. Click the Isometric button  from the Principles Views Flyout.   

2. Select Hide stock from the Hide fly-out in the Advanced toolbar.   

3. The default view of your solid model is shown in the top figure.  In this figure it is impossible to 
tell if there is a top on the solid.   

4. Click the Hidden Line  button.  It is located in the Display toolbar.  The graphics shown in the 
bottom figure are displayed.  In this figure it is clear that there is a top on 
the solid.   

5. While hidden line mode provides nice graphics, it is considerably slower 
than simple line drawings and sometimes hides portions of the model you 

need to pick, so click the Hidden Line  button again to toggle the line 
drawing mode.   

Note that hidden line graphics are only available for solids.   

Create the Curved Lower Surface 
1. Select Show stock from the Show fly-out in the Advanced toolbar.   

2. Double-click on the stock and click the Resize… button.  

3. Click Compute stock size from the size of the part, and click Next.  Click  Move stock and click 
Finish.   

4. Select the Front  button from the Principal Views 
flyout.  

5. Select the Geometry step  from the Steps toolbar. 

Click the Arc from Radius, 2 Pts  button. 

6. Set the Radius to 400. Set X1 to 120, Y1 to 0 and Z1 to –20. Set X2 to –10, Y2 to 0 and Z2 to –40, 
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and click the Create button.   

 

7. Create a second arc by entering 160 as the Radius and clicking on the right and left endpoints of 
the first arc.  If your arc curves up instead of down, click on the arc and click the Options button at 
the bottom of the screen. 

NOTE:   If the cursor is still in the arc create mode, click on the Select  button in the Standard 
toolbar. Now you are able to click on and select the arc.   

8. Select the top arc (the one you created first) and click the Transform  button. 

9. Click Translate and the Copy radio button. Enter 70 in the Y coordinate of XYZ distance and click 
OK.   

10. Select the bottom arc and click the Transform  button.   

11. Click Translate and the Move radio button and transform it 35 in the Y direction and click OK.   

12. Select Isometric  from the Principal views fly-out.   

13. Click the Solid Wizard  button from the Advanced toolbar.   

14. Select From curves as the method and Lofted as the constructor 
and click Next.   

15. Since we want to use this design feature to remove material, 

click the As Cut radio button and click the pick curve  button.   

16. Select the arcs in the order shown in the figure. If the selected arcs appear out of order in the curve 
list, use the arrows to move the arcs up or down. Click Finish. 

17. The curves are used to create a lofted surface and then the surface is used to cut the solid.  Note 
that an additional design feature, called loftcut1 is now listed in the part view.    

Create Constant and Variable Radius Fillets 

1. Click the Solid Wizard  button from the Advanced toolbar.   

2. Select Shape Modifiers as the method and Fillet Edges as the constructor and click Next.   

3. Enter 5 as the Radius, click the Pick curve  button and pick the edges 1-4 shown in the figure.   
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4. Click Variable and enter 5 as the Begin radius and 10 as the End radius and pick the edges 5-8 in 
the figure.  This will create a variable radius fillet on these edges. As 
you click each edge an arrow is displayed to show the edge direction.  
The first radius will be applied to the tail of the arrow and the second 
to the head of the arrow. 

5. Click Finish.    Note that the selected edges are filleted and the 
surrounding surfaces have been trimmed.  The corners where the 
fillets meet are automatically filleted.  

Add Thickness  

1. Click the Solid Wizard  button from the Advanced toolbar.   

2. Select Shape modifiers as the method and Shell as the constructor 
and click Next.   

3. Enter an Offset distance of -2 and click the Pick surface  
button.   

4. Click on the top surface as shown in the figure.  This surface will 
not be offset.  If the Select dialog box comes up, pick the name that 
corresponds to the top surface.  (The surfaces are highlighted in the 
graphics window as you select the names.)   

5. Click Finish. 

6. All faces of the solid except the top surface are now offset by 2 mm 
to provide thickness to the part.  Use hidden line graphics to display 
the graphics shown on the right.   

At this point, the solid model of the speaker is complete.   

Create a Mold Cavity 
Now the challenge is to create a mold from the solid model.  For parts that can be created with two 
mold halves, FeatureCAM’s core/cavity feature is a useful tool.   

1. Click the Solid Wizard  button from the Advanced toolbar.   

2. Select Manufacturing as the method and Select Core/Cavity as the constructor and click Next. 

3. Click the Bottom radio button.   

4. Click the Make solid from result.  This will create a new solid that contains the cavity faces.   
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5. Click Finish.  Note that a new solid, called sheet1, is listed in the part view.   

6. Right click on the solid1 in the parts view and select Hide Selected. You can now see the cavity. 

 

The Next Step 
You have completed this tutorial.   
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Chapter 13 
Introduction to FeatureWIRE 

NOTE:   You must license FeatureWIRE to perform this tutorial.   

In this tutorial you will learn the basics of creating wire EDM toolpaths using FeatureWIRE.   This 
tutorial is only available in inch units.  Specifically you will learn how to: 

• Set up your material and wire thickness. 

• Create wire EDM features. 

• Specify a wire EDM cutting strategy. 

• Simulate wire EDM toolpaths.   

Getting Started 
1. Begin FeatureCAM by selecting FeatureCAM from the Start menu.   

2. Click New Part Document  button.   

3. Click on Wire EDM Setup, click Inch and OK.   

4. Set the stock Width and Length to 4.0 and the thickness to 0.5 and click Finish.   

5. If the Stock Properties dialog box appears click OK. 

Creating the Profile 

1. Click the Curves step  from the Steps toolbox. 

2. Click the Create curves using the Curve wizard  button. 

3. Click Other methods and click Rectangle and click Next 

4. Click Use corner, width and height.   
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5. Set the corner point to 1,1,0. 

6. Set the corner radius to 0.5 and set the Width and Height to 2.0.  Click Finish.   

 

Creating a Wire EDM Feature 

1. Click the Features step from the Steps toolbox.   

2. Click the Die radio button in the 2 Axis group and click Next.  

3. Click the Pick curve  button and select the curve you just created. Click Next until you get to 
the Dimensions page. 

4. Enter 0.5 as the Thickness and click Next twice to get to the Strategies page.   

5. Select Retract as the operation and check the Cutoff and Contour checkboxes.   

6. Click Finish.  If the Die properties page appears click OK. 

Simulating a Wire EDM Toolpath 

1. Click the Toolpaths step.  The Simulation toolbar is displayed.   

2. Click the 2D simulation  button in the Simulation toolbar.  Move the speed control slider 

 to the middle so that the simulation is slowed down.   

3. Click the Play to Next Operation  button. You’ll notice that the Retract operation makes two 

passes. If you need to slow down the simulation, drag the Sim Speed control  to the left.  
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4. Click the Play to Next Operation  button again.  The Cutoff operation now takes two passes. 
(Slow down the simulation if you need to). 

5. Click the Play to Next Operation  button once more.  The final contour operation is now 
simulated.   

6. Click the Eject  button. 

Generating NC Code  

1. Click the NC Code step  in the Steps toolbar.  

2. Click the Display the NC code  button in the dialog box to generate the NC code.   

Add a Taper Angle 

1. Click on the Part View. Select the die1 feature from the list and click the Properties  button 
at the bottom of the screen. 

2. Click the Constant radio button.  Select Left as the taper type and 
enter 10 as the taper angle in the deg. field and click Apply.   

3. Click the Isometric view button  from the Standard toolbar to 
get a 3-dimensional view.   

4. Set the taper type to Right and click Apply. View the new shape in Isometric view. 
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5. Change the taper type back to Left and click OK. 

6. Click the Toolpaths  step. Click 3D  and click 
the Play button.   

Since this is a die feature, it is assumed that the region inside of 
the curve will be discarded.  

7. Click the Select  button from the Standard toolbar. 

8. Click on the stock in the region inside of the curve. 
FeatureCAM will now delete that part of the stock.  

9. Click the Eject  button.   

10. Click on the Part View and right-click the die1 feature to 
bring up a fly-out menu. Select the Hide Selected option. 
Now the feature will not be displayed on the screen. 

Creating the Second Profile 

1. Click the Curves step  from the Steps toolbox. 

2. Click the Create curves using the Curve wizard  button. 

3. Click Other methods and click Rectangle and click Next. 

4. Click Use corner, width and height and set the corner point to 0.5,0.5 ,0.0 

5. Set the Width and Height to 3.0.  Click Finish.   

Creating a 4-axis Wire EDM Feature 

1. Select the Top  button from the Principal Views fly-out. 

2. Click the Features step from the Steps toolbox.   

3. Click the Die radio button in the 4 Axis group and click Next.  

4. Click the Pick curve  button and select the curve that you just created. Click Next. 
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5. Click the Pick curve  button and select the curve that you 
created first. Keep clicking Next until you get to the Dimensions 
page. 

6. Enter 0.50 as the Thickness and click Finish. If the Die properties 
page appears click OK.  

 The feature is twisted because the start points were not set. 

Modifying the Start Point 
1. Click on Part View. Select the die4x1 feature from the list and 

click the Properties  button. 

2. Click on the Start tab. 

3. Click the Pick location button for the Upper Curve Start/End 
Point. 

4. In the graphics window, click on a point in the center of the stock. 

5. Click on the bottom horizontal line of the outer curve. You should 
notice a green line between the point and the edge of the curve. 

6. Click the Pick location button this time for the Lower Curve 
Start/End Point. 

7. Click in the center of the stock and click on the bottom horizontal 
line of the inner curve. 

8. Click OK. The feature now should no longer be twisted. 
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Matching the Curves 

1. Click on Part View. Select the die4x1 feature from the list and click the Properties  button. 

2. Click the Dimensions tab and click the Match Curves… button. 

3. Click the Pick lower curve point button. 

4. Select the point on the lower curve at location 1 then select 
the point on the upper curve at location 2. You should see a 
green line between the two points. 

5. Hold down the shift key and select the other point on the 
lower curve at location 3 then select again the corner point 
at location 4. Now you have matched both points on the 
lower curve to the single point on the upper curve. 

6. Click Apply and then OK in the Match Curves dialog box. 

7. Click OK in the Die Properties dialog box. 

Simulate the Part 
1. Click on the Part View and uncheck the box next to the die1 feature. When it’s unchecked the 

feature will not be shown in the simulation. 

2.  Click the Isometric view button  from the Standard toolbar.   

3. Click the Toolpaths  step. Click 3D 

 and click the play button.   

4. Click the Select  button from the 
Standard toolbar. 

5. Click on the region inside of the curve on 
the die feature.   

6. Click the Eject  button.   

The Next Step 
You have completed this tutorial.  
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Chapter 14 
FeatureMILL3D 2007 

Transition Guide 
Overview 

FeatureMILL3D 2007 has been extensively upgraded from FeatureCAM 2006. This upgrade resulted 
in many new roughing and finishing options in FeatureMILL3D 2007 as well as increased reliability 
and performance. We’re pleased that we were able to include these new capabilities without 
significantly changing FeatureMILL3D’s user interface.  In order to achieve these improvements a few 
compromises had to be made relative to previous versions.  In a few cases, strategies and options from 
previous versions had to be modified. Often there are new strategies in FeatureMILL3D 2007 that are 
equivalent to the previous functionality.  In other cases, users may find that converting to a new 
strategy in FeatureMILL3D 2007 will do a better job than the previous technology.  

This chapter is for users of previous versions of FeatureMILL3D software. It is intended to: 

1. Provide alternatives and suggestions for using the new technology available in 
FeatureMILL3D 2007. 

2. Explain the automatic conversion process for files from previous versions. 

3. Show how FeatureMILL3D version 2006 technology can still be used within version 
FeatureMILL3D 2007. 

4. Explain the manual conversion process for files from previous versions that contain 
incompatible options. 

 

Here are some important points to remember about FeatureMILL3D 2007: 

 Version 2007 contains many enhancements and new strategies. 

 As much as possible, the user interface and strategies in FeatureMILL3D 2007 are compatible 
with previous versions. 

 As a convenience, all the version 2006 technology is still available in version 2007, if 
necessary, for files saved by previous versions of FeatureCAM. 
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 Version 2006 technology will not be supported indefinitely. Users are strongly encouraged to 
convert any incompatible operations from existing files to use the new technology wherever 
possible. 

Backward Compatibility 
FeatureMILL3D 2007 uses a new machining library to compute surface milling tool-paths. This library 
completely replaces the old version 2006 machining library, but there are options from the old library 
that are not supported. To provide full backward compatibility, FeatureMILL3D 2007 includes both 
the new and the old libraries. The old library is provided to support files from previous versions when 
necessary, but will not be supported in the future.  

Reading Files from Previous Versions 
When a file from a previous version of FeatureCAM is read, each surface milling feature is examined. 
Each operation within a surface milling feature (e.g.: a parallel finish, or a Z rough) is checked for any 
incompatible settings. If any incompatible operations are found a warning dialog appears.   

 

 
 

Each incompatible operation is labeled so that it will use the version 2006 machining library to 
compute tool-paths. This label is visible in the operation list right-click menu (see next section). All 
compatible operations in all the surface milling features will automatically use the new machining 
library. All new features and operations created in FeatureMILL3D 2007 will only use the new 
machining library. A detailed list of the incompatibilities is included later in this document.  

Once the file is saved in version 2007, the warning will not appear when reading the file back into 
version 2007 although it may still contain incompatible operations marked to use the 2006 machining 
library.  
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Using Version 2006 Technology in Version 2007 
The version 2006 machining library is 
accessed via the operation list right-click 
menu. In the operation list window, if you 
select and right click on a surface milling 
operation you will see the menu on the right: 

In this case, a file from a previous version has 
been read into FeatureMILL3D 2007 with an 
incompatible X parallel operation (e.g.: it uses 
the scallop height option). After seeing the 
warning dialog above, the user can right click 
on the surface milling operations in the 
operations list to see which are incompatible. 
The menu will have the Use old 3d code item 
checked for any incompatible operations. 

Version 2006 Interface 
There are numerous differences between the 
surface milling user interface in version 2006 
and 2007. The training and help files provided 
with version 2007 provide the documentation 
for version 2007. For any surface milling 
operations using the version 2006 machining 
library, the version 2006 user interface is used 
for the feature operation pages (strategy, 
milling, etc.). There is no additional 
documentation for the version 2006 user 
interface. Be aware that these differences can 
be subtle and the only way you can be sure 
about an operation is the right-click operations 
menu.  

Converting an Incompatible Operation 
In many cases, an incompatibility may not be significant and the user may wish to convert the 
operation to use the version 2007 machining library. In many cases, this is as simple as un-checking 
the Use old 3d code item on the right-click operation list menu. The operation will retain all the 
compatible settings and ignore the rest. In other cases, the user will have to use the feature Process 
page to change the type of an operation to a version 2007 operation.  
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For instance, radial inward is incompatible 
with version 2007 since only outward radial 
patterns are now supported.  The user must 
use the process Properties to change to a 
version 2007 radial operation and then also 
make sure the Use old 3d item is un-checked 
in the right-click operation list menu. This 
process also applies to the case where you 
wish to convert an old operation to a new 
operation with a different strategy, but retain 
some of your common settings (step-over, 
tolerance, etc.) 

 

Step-by-Step Instructions for Converting an Operation  
For converting an operation to use the version 2007 machining library, there are two cases: 

Simple Conversion 
In most cases, the operation can just be switched to use the version 2007 machining library using the 
operation list right-click menu: 

1. Make sure the Results window is visible on the right-
hand side of the FeatureCAM window. 

2. Click the Op List tab. 

3. Select the operation in the list and right-click the 
mouse to bring up the fly-out menu. 

4. Un-check Use old 3d code. 
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Converting an Operation by Changing Strategy 
In other cases, you may need to change the strategy of an operation to use the version 2007 machining 
library. See table below for the cases where this is necessary. In this case the steps are: 

1. Open the surface milling properties 
dialog box. 

2. Select the feature in the tree view.  

3. Click the Process tab. 

4. Select the operation to convert 
(“radial”) from the list box. 

5. Click the Properties  button. This will bring up the New Strategy dialog.   

6. Select the “Radial” radio button and click Finish. 

 

7. Go to the Operation List in the Results window. 

8. Select the operation in the list and right-click the mouse to bring up the fly-out menu. 

9. Make sure Use old 3d code is un-checked 
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Incompatibilities 
This section lists all the incompatibilities between 2006 and 2007 and provides suggestions for 
alternative solutions using the 2007 machining library. The following table lists all the operations that 
will not be automatically converted to use the new 2007 machining library when reading a file saved 
from a previous version. The first column describes the operation from the previous version. The 
“Version 2007 technology” column gives some suggestions on how to convert the operation to use the 
new version 2007 machining library if applicable.  

 

Version 2006 
technology 

Version 2007 technology 

Plunge roughing This is an operation that is still fully supported, but it uses version 2006 
technology within version 2007. New plunge roughing operations can be 
created in version 2007. The operations will be labeled with use old 3d code 
in the operation list right-click menu.  

Parallel roughing 
(or finish with z 
increment set 

Z increments for parallel are not available via the parallel strategy. Instead, 
version 2007 provides a zig-zag option for Z roughing which is equivalent. 
However, no automatic conversion is provided. Use the operation properties 
to change into a Z rough operation. New Z roughing provides many 
improvements.  

Spiral, isoline, 
radial roughing (or 
finish with z 
increment set)  

Z rough pocket roughing is fairly similar to spiral roughing. Isoline and radial 
roughing are rarely used and have no real equivalent in 2007.  

Radial in Version 2007 radial operation only supports radial out (unidirectional or bi-
directional). Use operation properties to convert to a new 2007 radial 
operation. If radial in is absolutely required, use version 2006 library or 
convert to a flowline milling using a surface of revolution.  (Also note that if 
you set the “radius start” and the “radius end” attributes appropriately, the 
resulting V2007 tool-path is similar to a v2006 “radial in”).  

Z level finish or 
rough with bottom 
up option 

There is no equivalent of this option in version 2007. 

Z level finish with 
start points set 

Not supported.  

Z level finish with 
new technology 

Un-check Use old 3d code to convert to new Z finish operation and then use 
internal only edge boundary or user defined boundaries. This is superior to 
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NOT checked. This 
is an older version 
of Z level 
technology no 
longer supported.  

old Z slicing technology.  

Z rough open 
pocket option 

Not supported. Un-check use old 3d code and use Z rough boss option. Set 
an appropriate stock curve for equivalent machining with 2007. 

Independent pre-
drill operation. A 
pre-drill operation 
that does not 
precede a Z rough 
operation. 

Pre-drilling is only supported as an option of Z roughing (or new zig-zag Z 
roughing). If a Z roughing operation is present, the pre-drilling is converted to 
use the new machining library. If your old file used pre-drilling with parallel 
roughing, for example, delete the pre-drilling operation, convert the parallel 
roughing to a new Z roughing operation (see above) and use the pre-drilling 
option on the Leads tab.  

Parallel finish with 
scallop-height 
setting. 

Not supported in 2007. Z finish and remachining support scallop-height step-
overs. Another option is using parallel with the Add perp. Remach Pass 
option checked on the strategy tab.  

Spiral with uphill 
only or downhill 
only set. 

Not supported in 2007. Only parallel supports the uphill/downhill options.  

Spiral with start 
point set 

Not supported. 

4th axis wrapping Not supported. 4th axis wrapping for surface milling has very limited 
application. Version 2007 supports simultaneous 4-axis rotary milling which 
is superior to wrapping. No automatic conversion is provided. Use unwrapped 
surfaces and convert to new 4th axis surface milling operation.  

Parallel + 90 
remachining. This 
combination has 2 
separate 
operations. 

The separate remachining operation is not supported. The combination is 
supported by using a single parallel operation that makes two perpendicular 
parallel passes. Convert to a version 2007 parallel operation by editing the 
operation on the Process page. Then uncheck the use old 3d code item on the 
operation list right-click menu. Then check the Add perp. remach. Pass on 
the operations strategy page. This is equivalent to the version 2006 
combination operation.  

Ignored Settings 
The following settings are also no longer available in version 2007, but operations with these settings 
are not marked as incompatible when read from an old file. Instead, the operations will use the new 
machining library but these settings will be ignored. There is no warning dialog in this case. If these 
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settings are required, the operation can be converted back to use the version 2006 machining library by 
checking the Use old 3d code on the operation list right-click menu.  

 Edge rollover none – Edge rollover has been changed to Edge boundary in version 2007. 
Edge boundary Internal only and all are fairly equivalent to the version 2006 edge rollover 
options. There is no equivalent to the old edge rollover none. Version 2007 does have a new 
option which is edge boundary none which means that no restrictions whatsoever are applied 
to the tool-paths regarding edge contact. The tool-paths will cut the silhouettes of the part (as 
long at they are not restricted by the stock or other means).  

 First feed and Number of first feed paths – These options for controlling the feed rate are 
no longer available. Use lead-in’s and ramps.  

 Plunge points – This setting is no longer available. For Z roughing, use the pre-drilling option. 

 Retract gap – This setting is no longer required with the new machining library. Use the 
stepover rapid distance to control retracts and plunges.  

 Improved – Numerical improvement is no longer supported. The new machining library 
provides better tool-path point spacing and better accuracy than the old machining library. 

 Z interleaved spiral max slope – This setting is no longer available. It is automatically set. It 
might be provided in future versions.   
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